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This chapter contains the following topics:

About This Guide 1

About This Guide
This guide describes how to remove and replace the QX and QXS RAID chassis and expansion chassis 
FRUs/CRUs. The applicable systems include:

 l QXS-312/412 Hybrid

 l QXS-324/424 Hybrid

 l QXS-448/648 Hybrid

 l QXS-456/656 Hybrid

 l StorNext QXS-1200/2400

 l StorNext QXS-5600

 l StorNext QX-1200/2400

Note: Some parts may not be exactly the same item in older systems; the system parts are 
representative of the type parts within the above listed systems.

QX and QXS CRU Installation and Replacement Guide 1
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Intended Audience
This guide is intended for storage system administrators.

Prerequisites
Prerequisites for using this product include knowledge of:

 l Servers and computer networks

 l Network administration

 l Storage system installation and configuration

 l Storage area network (SAN) management and direct attach storage (DAS)

 l Fibre Channel (FC) , SAS, and Ethernet protocols

Related Documentation
For information about See

Web links to download Quantum QX and QXS Storage guides listed 
below, but not shipped with the product

QX and QXS Documentation Sheet*

Enhancements, known issues, and late-breaking information not 
included in product documentation

QX or QXS Release Notes

Product overview and overview of setup tasks QX and QXS Getting Started Guide

Regulatory compliance and safety and disposal information QX and QXS Series Product Regulatory 
Compliance and Safety *

Using a 12- and 24-drive rackmount bracket kit to install an chassis 
into a rack

QX/QXS 12- and 24-Drive Rackmount 
Bracket Kit Installation Guide

Using a 48-drive rackmount bracket kit to install an chassis into a 
rack

QXS 48-Drive Rackmount Bracket Kit 
Installation Guide

Using a 56-drive rackmount bracket kit to install an chassis into a 
rack

QXS 56-Drive Rackmount Bracket Kit 
Installation Guide

Installing the front bezel on a QX and QXS system QX and QXS Bezel Installation Guide

Product hardware setup and related troubleshooting QX and QXS Setup Guide 
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For information about See

Using the CLI to configure and manage the product QX and QXS CLI Reference Guide

Identifying and installing or replacing CRUs QX & QXS CRU Installation and 
Replacement Guide

Events that the QX and QXS Series may report, and recommended 
actions to take in response to those events

QX and QXS Event Descriptions 
Reference Guide 

Managing a QXS system by using its primary web interface (V3), the 
Disk Management Utility

QXS Disk Management Utility User 
Guide V3

Managing a QX and QXS system by using its secondary web 
interface (V2), the Disk Management Utility

QX and QXS Disk Management Utility 
User Guide V2

* Printed document included with product

For additional information, go to Quantum’s website,

Document Conventions and Symbols

Convention Element

Blue text Cross-reference links and e-mail addresses

Blue, underlined text Web site addresses

Bold text  l Key names
 l Text typed into a GUI element, such as into a box
 l GUI elements that are clicked or selected, such as menu and list items, buttons, 

and check boxes

Italic text Text emphasis

Monospace text  l File and directory names
 l System output
 l Code
 l Text typed at the command-line

Monospace, italic 
text

 l Code variables
 l Command-line variables

Monospace, bold 
text

Emphasis of file and directory names, system output, code, and text typed at the 
command-line

Table 1: Document conventions

http://www.quantum.com/
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Note: Note emphasizes important information related to the main topic.

Caution: Caution indicates potential hazards to equipment or data.

WARNING: Warning indicates potential hazards to personal safety.
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This chapter contains the following topics:

Available CRUs 5

Storage Chassis Overview 6

CRUs for 12-drive Chassis 8

CRUs for 24-drive Chassis 13

CRUs for 48-drive Chassis 18

CRUs for 56-drive Chassis 26

Available CRUs
You can determine which CRUs pertain to your storage chassis using the Command-line Interface (CLI). 
Access the controller via a Telnet client; log into the controller over the network (default user name manage 
and password !manage). If the default user or password—or both—have been changed for security 
reasons, enter the secure login credentials instead of the defaults shown above.

Enter a show crus query. 

Execution of the show crus CLI command displays controller metadata, followed by the CRU information 
pertaining to chassis (with midplane), controller I/O modules, expansion I/O modules, and power supplies.

Note: See  Quantum QX and QXS: CLI Reference Guide for more information.

QX and QXS CRU Installation and Replacement Guide 5
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You can also determine which CRUs pertain to your storage chassis by visual inspection of the component, 
noting serial number and part number. This method applies to drives. CRUs and CRU make-up are subject 
to change independent of documentation versions. Information about CRUs and other components can also 
be viewed via Disk Management Utility.

See www.quantum.com for the latest product information. 

Storage Chassis Overview
This guide identifies CRUs used in the 2U12 (12 drives), 2U24 (24 drives), 2U48 (48 drives) and 4U56 (56 
drives) products and describes how to remove and install the applicable CRUs.

The QXS-3/4/6 Series RAID chassis offer the following host interfaces:

 l CNC controller modules

 o FC SFP option supporting (4/8/16 Gb)

 o iSCSI (10 GbE) SFP option

 o iSCSI (1 Gb) SFP option (Copper RJ-45)

 l HD mini-SAS (12 Gb) controller modules

Note: The StorNext QX-1200, QX-2400, QXS-1200,  QXS-2400, and QXS-5600 use FC host 
interfaces.

The QXS-3/4/6 Series products support both traditional linear storage and new virtual storage, which uses 
paged-storage technology. For linear storage, a group of disks with an assigned RAID level is called a vdisk 
or linear disk group. For virtual storage, a group of disks with an assigned RAID level is called a virtual disk 
group. This guide uses the term vdisk when specifically referring to linear storage, and uses the term disk 
group otherwise.

The QXS-3/4/6 Series RAID chassis support attachment of expansion chassis for added storage. Refer to 
the QX and QXS Setup Guide for additional information.

Storage Chassis
Table 2 on the next page provides a list of the QXS-3/4/6 Series Hybrid, StorNext QXS, and StorNext QX 
systems (models, host interface, drives, form factor, and number of controllers).

Note: All systems ship with two controllers installed, except for the QXS-312 and QXS-324. The QXS-
312 and QXS-324 systems can ship with one or two controllers installed.

http://www.quantum.com/
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Model Host Interfaces Drive Form Factor Number of 
Controllers

QXS-312/QXS-412 CNC* or SAS 3.5” LFF (12 
drives)

2U12 2

QXS-324/QXS-424 CNC* or SAS 2.5” SFF (24 
drives)

2U24 2

QXS-448/QXS-648 CNC* or SAS 2.5” SFF (48 
drives)

2U48 2

QXS-456/QXS-656 CNC* or SAS 3.5” LFF (56 
drives)

4U56 2

StorNext QXS-1200 or QX-
1200 

FC only 3.5” LFF (12 
drives)

2U12 2

StorNext QXS-2400 or QX-
2400

FC only SFF (24 drives) 2U24 2

StorNext QXS-5600 FC only LFF (56 drives) 4U56 2

*CNC (converged network controller) allows for FC, iSCSI (10GbE), iSCSI (1 Gb) host interface connections using SFPs.

Table 2: QX and QXS Storage Systems

 User Interfaces
The storage chassis support two versions of the web-based application for configuring, monitoring, and 
managing the storage system. Both web-based application GUI versions (Disk Management Utility V3 and 
Disk Management Utility V2), and the command-line interface are briefly described:

• Disk Management Utility V3 is the new primary web interface for the chassis, providing access to all 
common management functions for both linear and virtual storage.

Refer to QXS Disk Management Utility User Guide V3  for additional information.

• Disk Management Utility V2 is a secondary web interface for the chassis, providing access to traditional 
linear storage functions. This legacy interface provides certain functionality that is not available in the 
primary interface.

Refer to QX and QXS Disk Management Utility User Guide V2 for additional information.

• The command-line interface (CLI) enables you to interact with the storage system using command syntax 
entered via the keyboard or scripting. You can set a CLI preference to use V3 or V2 terminology in 
command output and system messages.

Refer to QX and QXS CLI Reference Guide for additional information.

Contact your account manager for packaged CRU numbers and ordering information. Data 
addressing the  products is provided to supplement the illustrated replacement procedures described in 
Procedures Overview on page 37.
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Refer to the following section for applicable CRUs and illustrations of the chassis components.

 l  CRUs for 12-drive Chassis below

 l  CRUs for 24-drive Chassis on page 13

 l CRUs for 48-drive Chassis on page 18

 l CRUs for 56-drive Chassis on page 26

 CRUs for 12-drive Chassis
The  2U12 chassis—configured with 12  LFF drives (3.5")—is used for QXS-312, QXS-412, QXS-1200, and 
QX-1200 RAID chassis and optional expansion chassis. 

Figure 1: Bezel assembly - front view

The figure below shows a pictorial view of a 12-drive chassis. The bezel attaches to the chassis ball studs. 
The bezel installation process is the same for the 2U12/2U24/2U48 chassis.

Figure 2: Orientation key

1

2

1. Bezel 2. Ball Studs
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RAID or Expansion Chassis (2U12)
Figure 3 below provides an illustration of the RAID or expansion chassis (2U12 chassis).

Figure 3: Exploded view — RAID or expansion chassis (2U12)
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3
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Item Chassis component descriptions

1 Drive (LFF)

a) 3.5" drive module (drives of different type/speed and storage capacity: SAS, SSD)

b) HDDs or SSDs supported

2 a) Left ear assembly

b) Right ear assembly

3 Chassis

4 Midplane (included with chassis)

5 Power supplies (one shown)

a) AC power supply for chassis (newer power supplies do not have a power switch) 

b) DC power supply for chassis

6 Controller I/O module for chassis (one shown)

7 Chassis cover (included with chassis)

Not shown Chassis bezel sub-assembly featuring EMI shield and removable air filter
(see Newer Bezel Assemblies on page 12)

Table 3:  Product components for 12-drive chassis 

Figure 3 on the previous page through Figure 7 on page 12 illustrate 12-drive chassis models. Figure 6 on 
page 12 provides an assembly of the exploded view shown in Figure 3 on the previous page, and Figure 7 
on page 12 shows an assembly of component CRUs within the chassis. Although not shown in Figure 3 on 
the previous page, newer product models use an chassis bezel instead of ear caps (no longer used). The 
chassis bezel is shown in Figure 5 on the next page (removed) and Figure 6 on page 12 (installed), 
respectively.

Note: The following illustrations further describe components for the 12-drive chassis:

 l Controller I/O module pictorial — Figure 4 on the next page

 l Assembly — Figure 5 on the next page and Figure 6 on page 12

 l Internal components sub-assembly — Figure 7 on page 12

Controller I/O Module 
Figure 4 on the next page provides an illustration of the controller I/O module with a SFP transceiver.
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Figure 4: Controller I/O module with SFP transceiver

The controller I/O module shown in Figure 4 above is used instead of the expansion module (item No.6 in 
Figure 4 above) when the chassis is configured as a RAID chassis, rather than an expansion chassis. The 
transceiver is shown exploded from the IOM in the CNC example. Controller I/O modules equipped with 
CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. Controller 
I/O modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

Bezel Assembly
Caution: Whether configured with or without an air filter, to ensure adequate EMI protection for the 
drives, the bezel should be properly installed while the chassis is in operation.

Figure 5: Partial assembly showing bezel alignment (2U12) 

1

2

1. Bezel 2. Ball Studs
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Orient the bezel assembly to align its back side with the front face of the chassis as shown. Face the front of 
the chassis, and while supporting the base of the bezel, position it such that the mounting sleeves within the 
integrated ear caps align with the ball studs, and then gently push-fit the bezel onto the ball studs to attach 
the bezel to the front of the chassis. 

To remove the bezel, while facing the front of the chassis, insert the index finger of each hand into the top of 
the respective (left or right) pocket opening, and insert the middle finger of each hand into the bottom of the 
respective opening, with thumbs on the bottom of the bezel face. Gently pull the top of the bezel while 
applying slight inward pressure below, to release the bezel from the ball studs.

Note: For more information about servicing or replacing the removable air filter option for this particular 
bezel, refer to the Bezel Installation instructions included in your product ship kit.

Figure 6: Chassis assembly with bezel installed (2U12)

Figure 7: Chassis architecture — internal components sub-assembly (2U12)

1

2

3

4

1. Drive module

2. Midplane

3. Power supply unit

4. I/Omodule

Newer Bezel Assemblies
Newer models of the LFF 12-drive chassis support a bezel sub-assembly that attaches to the front of the 
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chassis (see Figure 5 on page 11). The bezel—comprised of a vented cover attached to an EMI 
(Electromagnetic Interface) shield—is pre-assembled and packed with foam into a box included in the 
master shipping container. The bezel might optionally include a removable air filter that can be serviced or 
replaced. Hard copy instructions for attaching/removing the bezel, and for servicing or replacing the air 
filters, are provided in the shipping container of a new chassis.

 CRUs for 24-drive Chassis
The 24-drive chassis (2U24 chassis)—configured with 24 SFF drives (2.5")—is used for the RAID chassis 
and optional expansion chassis in the QXS-324, QXS-424, QXS-2400. and QX-2400 systems. 

Figure 8: Bezel assembly - front view

The figure below shows a pictorial view of a 24-drive chassis. The bezel attaches to the chassis ball studs. 
The bezel installation process is the same for the 2U12/2U24/2U48 chassis.

Figure 9: Partial assembly showing bezel alignment (2U24)

1. Ball stud on chassis ear (4 places)

2. Pocket opening (2 places)

3. Bezel

Note: Numbered items from Table 4 on the next page are shown in Figure 10 on the next page. Tinted 
items from Table 4 on the next page are shown in Figure 11 on page 16.
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RAID or Expansion Chassis (2U24)
Figure 10 below provides an illustration of the RAID or expansion chassis (2U24 chassis).

Figure 10: Exploded view — RAID or expansion chassis (2U24)

1

2b

3

4

5

6

7

2a

Item Chassis component descriptions

1 Drive (SFF)

a) 2.5" drive module (drives of different type/speed and storage capacity: SAS, SSD)

b) HDDs or SSDs supported

Table 4: Product components for 24-drive chassis 
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Item Chassis component descriptions

2 Ear kit

a) Left ear assembly

b) Right ear assembly

Also see Newer Bezel Assemblies on page 18

3 Chassis (sheet metal flanges on internal IOM bay assembly are omitted from Figure 10 on the 
previous page for visual clarity)

4 Midplane (included with chassis)

5 Power supplies (one shown)

a) AC power supply for chassis (newer power supplies do not have a power switch)

b)  DC power supply for chassis

6 I/O module for chassis (one shown, two allowed per chassis)

4124, 1JM, mini-SAS (SFF-8088), 2-port [6 Gbit/s]

7 Chassis cover (included with chassis)

  Controller I/O module for chassis [two allowed per RAID chassis] (see Figure 11 on the next page)

a) 4824, 1RM, 4-port CNC, FC [8/16 Gbit/s] SFP option

 Small form-pluggable (SFP) connectors (see Figure 11 on the next page)

a) SFP transceiver (applies to CNC models only: FC, 10GbE iSCSI, 1 Gb iSCSI)

Not 
shown

Rail kits (variable options)

a) Rack mount kit, shelf, short, All HW 22.5" - 31"

b) Rack mount kit, shelf, long, All HW 25" - 36"

c) Rack mount bracket kit, 2-Post adjustable, All HW

Not 
shown

Cable kit [Cable package: USB Type B; CLI (USB)]

Not 
shown

AC power cord compatible with AC power supply unit; or
DC power cable compatible with DC power supply unit
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Figure 10 on page 14 through Figure 14 on page 18 illustrate 24-drive chassis models. Item No.6 (above) is 
a supported expansion module. Figure 11 below shows a newer  controller I/O module also supported by the 
chassis. Although not shown in Figure 10 on page 14, newer product models use an chassis bezel instead of 
ear caps (no longer used). The chassis bezel is shown in Figure 9 on page 13 (removed) and in Figure 13 on 
the next page (installed), respectively.

Controller I/O Module
Note: The following illustrations further describe components for the 24-drive chassis:

 l Controller I/O module pictorial — Figure 11 below

 l Assembly — Figure 9 on page 13 and Figure 13 on the next page

 l Internal components sub-assembly — Figure 14 on page 18

Figure 11: Controller I/O module with SFP transceiver

The controller I/O module shown in Figure 11 above is used instead of the expansion module (item No.6 in 
Figure 10 on page 14) when the chassis is configured as a RAID chassis, rather than an expansion chassis. 
The transceiver is shown exploded from the IOM in the CNC example. Controller I/O modules equipped with 
CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options.
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Figure 12: Partial assembly showing bezel alignment (2U24)

1. Ball stud on chassis ear (4 places)

2. Pocket opening (2 places)

3. Bezel

Bezel Assembly
Orient the bezel assembly to align its back side with the front face of the chassis as shown. Face the front of 
the chassis, and while supporting the base of the bezel, position it such that the mounting sleeves within the 
integrated ear caps align with the ball studs, and then gently push-fit the bezel onto the ball studs to attach 
the bezel to the front of the chassis. 

To remove the bezel, while facing the front of the chassis, insert the index finger of each hand into the top of 
the respective (left or right) pocket opening, and insert the middle finger of each hand into the bottom of the 
respective opening, with thumbs on the bottom of the bezel face. Gently pull the top of the bezel while 
applying slight inward pressure below, to release the bezel from the ball studs.

Figure 13: RAID chassis assembly with bezel installed (2U24)
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Figure 14: RAID chassis architecture — internal components sub-assembly (2U24)

1

2

3

4

1. I/O module

2. Midplane

3. Power supply unit

4. Drive module

Newer Bezel Assemblies
Newer models of the SFF 24-drive chassis support a bezel sub-assembly that attaches to the front of the 
chassis (see Figure 9 on page 13). The bezel—comprised of a vented cover featuring integrated ear caps—
is pre-assembled and packed with foam into a box included in the master shipping container.

CRUs for 48-drive Chassis
The 48-drive chassis (2U48 chassis), configured with 48 SFF  drives (2.5”), is used within the RAID chassis 
and optional expansion chassis in the QXS-448 and QXS-648 systems. 

Figure 15: Bezel assembly - front view

The figure below shows a pictorial view of a 48-drive chassis. with three drawers. The bezel attaches to the 
chassis ball studs. The bezel installation process is the same for the 2U12/2U24/2U48 chassis.
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Figure 16: Partial assembly showing bezel alignment with 2U48 chassis

1

2

3

1. Chassis bezel (includes EMI shield for drives)

2. Ball stud on chassis ear (typical 4 places on chassis)

3. Pocket opening (typical 2 places on bezel)

Use Table 5 on the next page and Figure 17 on the next page for location and descriptions of chassis 
components.

RAID or Expansion Chassis (2U48)
Figure 17 on the next page provides an illustration of the RAID or expansion chassis (2U48 chassis). 
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Figure 17: Exploded view: RAID or expansion chassis (2U48)

90°

1a

1c 1b

2a

2b

(Note 1)

(Note 1)

3

4

5

6

7

8

Illustrated Parts Breakdown: 2U48 Chassis FRUs

(For clarity, redundant assembly components are not shown)

1. The enclosure bezel is only partially shown.

2. The bezel is equipped with an EMI shield.

3. The bezel must be attached during enclosure operation.

4. Remove the bezel to access front panel components.

Notes:

Fore
A f t

Front Right Side

Orientation Key

5. Use management interfaces in lieu of removing bezel.

Item Chassis component descriptions

1 Chassis drawer (one drawer shown—pulled forward to drawer stop—included with chassis)

a) Empty drawer chassis assembly (PCBAs, power module and SAS data cable connector)

b) 2.5" disk drive module (disks of differing type/speed and storage capacity: SAS, SSD)

c) Air Management Solution insert (blank to maintain optimum air flow within chassis) 

2 Ear kit

a) Left ear assembly

b) Right ear assembly

Also see Figure 16 on the previous page

Table 5: 48-Drive chassis
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Item Chassis component descriptions

3 Chassis [with drawer slide and igus chain (data and power cables) shown]

4 Midplane (included with chassis)

5 Power supplies (one AC PSU module shown)

6 Controller I/O module for chassis [two per RAID chassis] (see CNC controller I/O module with 
SFP transceiver on the next page)

a) 4-port CNC, FC [8/16 Gbit/s] SFP option

b) 4-port CNC, iSCSI [10GbE] SFP option

c) 4-port CNC, iSCSI [1 Gbit/s] RJ-45 SFP option

d) HD mini-SAS, 4-port [12 Gbit/s] SFF-8644 external connector

7 Small form-pluggable (SFP) connector (applies to CNC controller I/O modules only)

8 Chassis cover (included with chassis)

Not 
shown

Expansion I/O module (two per chassis when configured as an expansion chassis)

J6G48, 1JM, mini-SAS (SFF-8088), 2-port [6 Gbit/s]

Not 
shown

Rail kit [Rack mount rail kit, assembly, All HW]

Not 
shown

Cable kit [Cable package: mini-SAS (SFF-8088) to mini-SAS (SFF-8088)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to HD mini-SAS (SFF-8644)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to mini-SAS (SFF-8088)]

Not 
shown

Cable kit [Cable package: USB Type B; CLI (USB)]

Not 
shown

AC power cord compatible with AC power supply unit.

Controller I/O Module
Figure 18 on the next page provides an illustration of the controller I/O module with an SFP transceiver (right 
side of graphic).
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Figure 18: CNC controller I/O module with SFP transceiver

The transceiver is shown exploded from the IOM in the CNC example. Controller I/O modules equipped with 
CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. Controller 
I/O modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

Drawer Assembly
Figure 19 below provides an illustration of the chassis with the bezel installed. The bezel must be removed to 
access the drawers within the 48-drive chassis.

Figure 19: Chassis assembly with bezel installed (2U48)

Note: Refer to the QX and QXS Bezel Installation Guide for bezel installation instructions.

Assembly with Bezel Removed
Figure 20 on the next page provides an illustration of the bezel removed from the 48-drive chassis (drawer 
handles visible).
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Figure 20: Chassis assembly with bezel removed (2U48)

Internal Components
Figure 21 below provides an illustration of the internal components in the 48-drive chassis (only 1 drawer 
shown).

Figure 21: Chassis architecture: internal components sub-assembly (2U48)

90°

1

2

3

4
5

6

1. Chassis drawer

2. Power supply

3. Controller I/O module

4. Midplane

5. Drive module

6. AMS insert
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Bezel Assembly
The 48-drive 2U48 chassis supports a bezel sub-assembly that attaches to the front of the chassis (see 
Figure 16 on page 19). The bezel—comprised of a vented cover attached to an EMI (Electromagnetic 
Interference) shield—is pre-assembled and packed with foam into a box included in the master shipping 
container.

Figure 22: Partial assembly showing bezel alignment with 2U48 chassis

1

2

3

1. Chassis bezel (includes EMI shield for drives)

2. Ball stud on chassis ear (typical 4 places on chassis)

3. Pocket opening (typical 2 places on bezel)

Opening and Closing a Drawer
You can open a drawer for visual inspection of drive bays. Before accessing the drawer via its handle, you 
must first remove the chassis bezel (see chassis bezel removal on page 74). Given that the chassis bezel is 
required to provide EMI protection, you should re-attach the bezel to the chassis after examining the drawer.

 1. Using a Torx T15 or straight blade screwdriver, loosen the drawer stop screw on the front face of the 
drawer. 

 l Once the screw is loosened, turn the outer thumbwheel counter-clockwise to unlock the drawer. 
Take care not to remove the screw.

 l Figure 23 on the next page provides a 2U48 drive chassis front panel with bezel removed and 
showing drawer 0 (left), drawer 1 (middle), and drawer 2 (right).
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Figure 23: Opening a drawer: loosen the drawer stop screw

1 20

Note: Loosen the screw on the target drawer.

 2. Revolve the drawer handle upwards by 90 degrees to enable pulling the drawer outward for viewing 
drives.

The drawer handle functions identically on all drawers.

Figure 24: Opening a drawer: revolve the handle

90°
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 3. Face the front of the drawer—and using the handle—pull the drawer outward along the drawer slide.

Figure 25: Opening and closing drawer

90°

 4. Pull the drawer outward until it meets the drawer stop.

To close the drawer, simply slide the drawer into the chassis along the drawer slide until it properly 
seats in the drawer bay.

 l Take care to ensure there are no loose cable wires protruding beyond the limits of the igus chainflex 
cable.

 l After closing the drawer, revolve the handle downwards such that it is flush with the drawer front 
panel—in its stowed position—and re-attach the bezel to the front of the chassis.

CRUs for 56-drive Chassis
The  2U56 chassis—configured with 56 LFF drives (3.5")—is used for  RAID chassis and optional expansion 
chassis in the QXS-456, QXS-656, and QXS-5600 systems. 
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Figure 26: Bezel assembly - front view

The figure below shows a pictorial view of a 56-drive chassis. The bezel slips over the two upturned flanges 
(bottom of chassis) and attaches to the chassis ball studs (top of chassis). 

Figure 27: Orientation Key

 

Use Table 6 on the next page and Figure 28 on the next page for location and descriptions of chassis 
components.

Note: Numbered items from Table 6 on the next page are shown in  Figure 28 on the next page . Tinted 
items from Table 6 on the next page are shown in Figure 29 on page 30.
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RAID or Expansion Chassis (4U56)
Figure 28 below provides an illustration of the RAID or expansion chassis (4U56 chassis).

Figure 28: Exploded view — RAID or expansion chassis (4U56)

Illustrated Parts Breakdown: 4U56 Chassis FRUs

(For clarity, redundant assembly components are not shown)

Orientation Key

1. The enclosure bezel is only partially shown.

3. The bezel is equipped with an EMI shield.

4. The bezel must be attached during enclosure operation.

5. Remove the bezel to access front panel components.

Notes:

6. Use management interfaces in lieu of removing bezel.

AssuredSAN

(Note 2)

2. Ear kits are shown assembled and exploded.

2b

(Note 2)

1a

1b

3

4

5a

5b

68

9

7

10

2a

Item Chassis component descriptions

1 Chassis drawer (shown pulled forward to drawer stop)

a) Empty drawer chassis assembly (PCBAs, power module and SAS data cable connector)

b) 3.5" drive module (drives of different type/speed and storage capacity: SAS, SSD)

Table 6: Product components for 56-drive chassis 



Chapter 2: CRUs
CRUs for 56-drive Chassis

QX and QXS CRU Installation and Replacement Guide 29

Item Chassis component descriptions

2 Ear kit

a) Left ear assembly

b) Right ear assembly

Also see Partial assembly showing bezel alignment (2U24) on page 13

3 Chassis [with drawer slide and igus chain (data and power cables) shown]

4 Midplane (included with chassis)

5 Power supplies (one shown)

a) AC power supply for chassis

b) Power supply extension module

6 Igus chainflex assembly (Shown coiled, with unplugged data and power cables. Connectors plug into 
horizontal PCBA at back-end of drawer)

7 Fan Control Module (two per chassis)

8 Controller I/O module for chassis [two per controller chassis] (see Controller I/O module with SFP 
transceiver on page 16)

a) 4-port CNC, FC [8/16 Gbit/s] SFP option

b) HD mini-SAS, 4-port [12 Gbit/s]

9 Small form-pluggable (SFP) connector (applies to CNC controller I/O modules only)

10 Chassis cover (included with chassis)

Not 
shown

Expansion I/O module (two per chassis when configured as an expansion chassis)

J6G56, 1JM, mini-SAS (SFF-8088), 2-port [6 Gbit/s]

Not 
shown

Rail kit [Rack mount rail kit, assembly, All HW]

Not 
shown

Cable kit [Cable package: mini-SAS (SFF-8088) to mini-SAS (SFF-8088)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to HD mini-SAS (SFF-8644)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to mini-SAS (SFF-8088)]

Controller I/O Module
Figure 29 on the next page provides an illustration of the controller I/O module with an SFP transceiver (right 
side of graphic). 
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Figure 29: CNC controller I/O module with SFP transceiver

The transceiver is shown exploded from the IOM in Figure 29 above. Controller I/O modules equipped with 
CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. Controller 
I/O modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

Drawer Assembly
Figure 30 below, Figure 31 on the next page, Figure 32 on the next page, and Figure 33 on page 32 provide 
illustrations of the 4U56 drawer assembly.

Figure 30: Partial assembly showing bezel alignment (4U56)

Note: Refer to the QX and QXS Bezel Installation Guide for bezel installation instructions.
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Assembly with Bezel Installed
Figure 31 below provides an illustration of the bezel installed on the 4U56 chassis.

Figure 31: Assembly with bezel installed (4U56)

Assembly with Bezel Removed
Figure 32 below provides an illustration of the bezel removed from the 4U56 chassis (drawer handles 
visible).

Figure 32: Assembly with bezel removed (4U56)
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Internal Components
Figure 33 below provides an illustration of the internal components in the 4U56 chassis (only 1 drawer 
shown).

Figure 33: Assembly with internal components (4U56/1 drawer)

 
1. Drive module

2. Igus chainflfex assembly

3. Fan control module

4. IOM

5. Power supply

6. Midplane

7. Chassis drawer

Bezel Assembly
The bezel assembly is easy to install and remove. Refer to Figure 34 on the next page for an illustraion of 
installing and removing the bezel assembly.

Note: The 56-drive 4U56 chassis supports a bezel assembly that attaches to the front of the chassis. 
The bezel—comprised of a vented cover attached to an EMI (Electromagnetic Interference) shield—is 
pre-assembled and packed with foam into a box included in the master shipping container. 

Installing the Bezel
Orient the chassis bezel to align its back side with the front face of the chassis. Tilt the bezel forward, and 
guide the two angle-bracket slots on the backside of the bezel onto the two upturned flanges located on side 
mount brackets near the front of the chassis (on the exterior left and right chassis walls). Then, gently push 
the sleeves onto the ball studs as shown in Figure 34 on the next page.
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Figure 34: Partial assembly showing bezel alignment (4U56)

Removing the Bezel
Refer to Figure 35 on the next page. While facing the front of the chassis, insert the index finger of each 
hand into the top of the respective (left or right) pocket opening. Gently pull the top of the bezel while 
applying slight inward pressure below to release the top sleeves from the ball studs. Lift the bezel upwards 
to allow the angle-bracket slots to clear the upturned mounting flanges.
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Figure 35: Removing Bezel (4U56)

Opening a Drawer
Once you have removed the bezel, you can access the drawers. Refer to Figure 36 on the next page.
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Figure 36: RAID chassis assembly with bezel installed (4U56)

90°

Drawer handle

S t o w  p o s i t i o n

P u l l  p o s i t i o n

Revolve handle to suit open

and close drawer actions.

Drawer 0 Drawer 1

To open a drawer, you must first revolve the pull-handle downwards by 90° to enable pulling the drawer 
outward for viewing drives. The handle can be in the stowed position when pushing the drawer back into the 
chassis along the drawer slide.
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Procedures Overview
This chapter provides procedures for replacing CRUs (customer-replaceable units), including precautions, 
removal instructions, installation instructions, and verification of successful installation. Each procedure 
addresses a specific task. Certain procedures refer to related documentation. See Related Documentation 
on page 2 for a list of these documents and where to find them online.

Electrostatic Discharge
Before you begin any of the procedures, consider the following precautions and preventive measures. 

Preventing Electrostatic Discharge
To prevent electrostatic discharge (ESD) from damaging the system, be aware of the precautions to 
consider when setting up the system or handling parts. A discharge of static electricity from a finger or other 
conductor may damage system boards or other static-sensitive devices. This type of damage may reduce 
the life expectancy of the device.

Caution: Parts can be damaged by electrostatic discharge. Follow these precautions:

 l Avoid hand contact by transporting and storing products in static-safe containers.

 l Keep electrostatic-sensitive parts in their containers until they arrive at static-protected workstations.

 l Place parts in a static-protected area before removing them from their containers.

 l Avoid touching pins, leads, or circuitry.

 l Always be properly grounded when touching a static-sensitive component or assembly.

 l Remove clutter (plastic, vinyl, foam) from the static-protected workstation.
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Grounding Methods to Prevent Electrostatic Discharge
Several methods are used for grounding. Adhere to the following precautions when handling or installing 
electrostatic-sensitive parts.

Caution: Parts can be damaged by electrostatic discharge. Use proper anti-static protection:

 l Keep the replacement FRU in the ESD bag until needed; and when removing a FRU from the chassis, 
immediately place it in the ESD bag and anti-static packaging.

 l Wear an ESD wrist strap connected by a ground cord to a grounded workstation or unpainted surface of 
the computer chassis. Wrist straps are flexible straps with a minimum of 1 megohm (± 10 percent) 
resistance in the ground cords. To provide proper ground, wear the strap snug against the skin.

 l If an ESD wrist strap is unavailable, touch an unpainted surface of the chassis before handling the 
component.

 l Use heel straps, toe straps, or boot straps at standing workstations. Wear the straps on both feet when 
standing on conductive floors or dissipating floor mats.

 l Use conductive field service tools.

 l Use a portable field service kit with a folding static-dissipating work mat.

If you do not have any of the suggested equipment for proper grounding, have an authorized reseller install 
the part. For more information about static electricity or assistance with product installation, contact an 
authorized reseller.

Replacing Chassis FRU Components
Chassis FRUs replace a damaged chassis or chassis components. A fully functional chassis requires 
successful installation of the following components:

 l Two controller I/O modules of the same model (for a given RAID chassis)

Note: Each I/O module (IOM) slot within the chassis must contain an IOM to enable optimum air 
flow through the chassis during operation. Whether configured as a RAID chassis or a drive 
chassis, the QXS chassis supports dual-controller configuration only.

See Replacing a Controller I/O Module or Expansion I/O Module on the next page for more information.

 l All drives modules (SAS, SSD)

See Replace a 56-Drive Module on page 77 for more information.

 l Two power supply modules of the same type (both AC or both DC)

See Replace a 56-Drive Chassis PSU and Fan Module on page 103 for more information.

 l Two ears with components installed (complementary left and right ear kits)
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See Replacing ear components on page 45 for more information; also see 56-Drive Chassis Ear 
Components on page 120 for 4U56 chassis bezel alignment.

Note: Newer product models use an chassis bezel instead of ear covers. If your model is equipped 
with a bezel instead of ear covers, see the appropriate illustration for bezel installation and removal:

 l See 56-Drive Chassis Ear Components on page 120 for 4U56 chassis bezel alignment.

 l See Figure 9 on page 13 for 2U24 chassis bezel alignment.

 l See Figure 5 on page 11 for 2U12 chassis bezel alignment.

 l Two expansion modules of the same model (per optional expansion chassis)*

See Replacing a Controller I/O Module or Expansion I/O Module below for more information.

In addition to the FRUs identified above, replacement procedures are provided to address specific interface 
protocols and replacement of the  chassis:

 l Removal and installation of a Fibre Channel transceiver

See Replace an FC Transceiver on page 124 more information.

 l Removal and installation of a storage  chassis

See Replace a Storage Chassis on page 127 for more information.

Replacement of chassis FRU components are described within this chapter.

Note: RAID chassis support hot-plug replacement of redundant controller I/O modules, fans, power 
supplies, and I/O modules. Hot-add of drive chassis is also supported.

Note: Many procedures refer to component LEDs and LED statuses. See the  QX and QXS Setup 
Guide for descriptions of model-specific front panel and rear panel LEDs.

Note: Within the  QX and QXS Setup Guide, see “Troubleshooting > Fault isolation methodology” for 
information about using health icons/values—in addition to using LEDs—for verifying component 
failure before actually replacing the FRU.

Replacing a Controller I/O Module or Expansion 
I/O Module
In a dual-controller configuration, controller I/O and expansion I/O modules are hot-swappable, which 
means you can replace one module without halting I/O to drive groups, or powering off the chassis. In this 
case, the second module takes over operation of the storage system until you install the new module.

You may need to replace a controller I/O module or an expansion I/O module when:

 l The Fault/Service Required LED is illuminated

 l Health status reporting in Disk Management Utility indicates a problem with the module
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 l Events in Disk Management Utility indicate a problem with the module

 l Troubleshooting indicates a problem with the module 

Note: RAID chassis equipped with CNC controller I/O modules support the optionally-licensed remote 
replication feature; whereas chassis equipped with SAS controller I/O modules do not.

Caution: When replacing a Quantum QXS Storage controller set supporting remote replication feature 
with a Quantum QXS Storage controller set that does not support this licensed feature, you must first 
delete all replication sets before swapping the controller I/O modules. Not doing so will lead to 
unexpected results, and there is no way to delete replication sets after the installation. See the following 
for additional information:

 l Disk Management Utility (V2 or V3)

 l QX and QXS CLI Reference Guide

Before You Begin
Removing a controller I/O or expansion I/O module from an operational chassis significantly changes air 
flow within the chassis. Openings must be populated for the chassis to cool properly. Leave modules in 
the chassis until ready to install a replacement. If replacing both controllers in the dual-control chassis, 
use the Disk Management Utility to record configuration settings before installing the new controller I/O 
modules. 

See Removing a Controller I/O Module or Expansion I/O Module on page 45, and Installing a Controller 
I/O Module or Expansion I/O Module on page 49 for instructions on installing an additional controller I/O 
module.

Caution: When replacing a controller I/O module, ensure that less than 10 seconds elapse 
between inserting it into a slot and fully latching it in place. Not doing so might cause the controller to 
fail. If it is not latched within 10 seconds, remove the controller I/O module from the slot, and repeat 
the process.

The two controller I/O modules installed in the chassis must be of the same model type. When replacing 
both controller I/O modules in an operational chassis, follow these guidelines:

1. Replace one controller as described in these instructions.

2. Wait 30 minutes: this pause ensures that the controller and its ownership of drive groups has 
sufficient time to stabilize (also Verifying Component Operation on page 51).

3. Check the system status and event logs to verify that the system is stable.

4. Replace the partner controller as described in these instructions.

Configure Partner Firmware Update
In a dual-controller system in which Partner Firmware Update (PFU) is enabled, when you update firmware 
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on one controller, the system automatically updates the partner controller. Disable partner firmware update 
only if requested by a service technician.

Use WBI, Disk Management Utility User Guide V3, or the CLI Reference Guide to change the PFU setting 
and to update the controller firmware.

Disk Management Utility User Guide V3
Caution: See the “Updating firmware” topic within the Quantum QXS Disk Management Utility User 
Guide V3before performing a firmware update.

1. Sign-in to Disk Management Utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. Click in the System panel in the banner, and select Action > Update Firmware.

The Update Firmware panel opens. The Update Controller Modules tab shows versions of firmware 
components that are currently installed in each controller.

Note: The Disk Management Utility User Guide V3 does not provide a check-box for enabling or 
disabling Partner Firmware Update for the partner controller. 

To enable or disable the setting, use the set advanced-settings command, and set the partner-
firmware-upgrade parameter. See the CLI Reference Guide for more information about command 
parameter syntax. Also see Using the CLI on the next page.

3. Click Apply.

Disk Management Utility User Guide V2
Caution: See the “Updating firmware” topic within the Disk Management Utility User Guide V2  before 
performing a firmware update.

1. Sign-in to Disk Management Utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. Click in the Configuration View panel, right-click the system and select Configuration > Advanced 
Settings > Firmware.

3. Either select (check) the Partner Firmware Update check box to enable the option, or clear the check 
box to disable the option.

4. Click Apply.
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Using the CLI
You can set a CLI preference to use V3 or V2 terminology in command output and system messages.

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log-in to the command-line interface using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above. 

2. To verify that partner firmware upgrade is enabled, run the following command:
show advanced-settings

3. If partner firmware upgrade is disabled, enable it by running the following command:
set advanced-settings partner-firmware-upgrade enabled

Note: See  QX and QXS CLI Reference Guide for additional information.

Verify Component Failure
Select from the following methods to verify component failure:

 l Use Disk Management Utility to check the health icons/values of the system and its components to either 
ensure that everything is okay, or to drill down to a problem component. Disk Management Utility uses 
health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If you 
discover a problem component, follow the actions in its Health Recommendations field to resolve the 
problem.

 l As an alternative to using Disk Management Utility, you can run the show system command in the CLI to 
view the health of the system and its components. If any component has a problem, the system health 
will be Degraded, Fault, or Unknown. If you discover a problem component, follow the the actions in its 
Health Recommendations field to resolve the problem.

 l Monitor event notification — With event notification configured and enabled, use Disk Management 
Utility to view the event log, or use the CLI to run the show events detail command to see details for 
events.

 l Check Fault/Service Required LED (back of chassis): Amber = Fault condition.

 l Check that the FRU OK LED (back of chassis) is off.

Stop I/O
When troubleshooting drive and connectivity faults, stop I/O to the affected vdisks from all hosts and remote 
systems as a data protection precaution. As an additional data protection precaution, it is helpful to conduct 
regularly scheduled backups of your data. 
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Caution: Stopping I/O to a vdisk is a host-side task, and falls outside the scope of this document.

When on-site, you can verify that there is no I/O activity by briefly monitoring the system LEDs; however, 
when accessing the storage system remotely, this is not possible. Remotely, you can use the show vdisk-
statistics command to determine if input and output has stopped. Perform these steps:

1. Using the CLI, run the show vdisk-statistics command.

The Number of Reads and Number of Writes outputs show the number of these operations that 
have occurred since the statistic was last reset, or since the controller was restarted. Record the 
numbers displayed.

2. Run the show vdisk-statistics command a second time.

This provides you a specific window of time (the interval between requesting the statistics) to determine 
if data is being written to or read from the drive. Record the numbers displayed.

3. To determine if any reads or writes occur during this interval, subtract the set of numbers you recorded in 
Step 1 from the numbers you recorded in Step 2.

 l If the resulting difference is zero, then I/O has stopped.

 l If the resulting difference is not zero, a host is still reading from or writing to the drive group. Continue 
to stop I/O from hosts, and repeat Step 1 and Step 2 until the difference in Step 3 is zero.

Note: See QX and QXS CLI Reference Guide for additional information.

Shut Down the Controller I/O Module
Shutting down the Storage Controller in a controller I/O module ensures that a proper failover sequence is 
used, which includes stopping all I/O operations and writing any data in write cache to drive. If the Storage 
Controller in both controller I/O modules is shut down, hosts cannot access the system’s data. Perform a 
shut down before you remove a controller I/O module from an chassis, or before you power off its chassis for 
maintenance, repair, or a move.

Caution: You can continue to use the CLI when either or both Storage Controllers are shut down, but 
information shown might be invalid.

Use WBI, Disk Management Utility User Guide V3, or the CLI to perform a shut down.

Using Disk Management Utility V3
1. Sign-in to the disk management utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown.

2. In the System panel in the banner, click and select Restart System.

The Controller Restart and Shut Down panel opens.

3. Select the Shut Down operation, which automatically selects the controller type Storage.
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4. Select the controller I/O module to shut down: A, B, or both.

5. Click OK. A confirmation panel appears.

6. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

Using Disk Management Utility V2
1. Sign-in to Disk Management Utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the system and select Tools > Shut Down or Restart 
Controller.

The Shut Down or Restart Controller panel appears.

3. In the Shut Down or Restart Controller panel, set the options:

 l Operation: select Shut down.

 l Controller type: select Storage.

 l Within the Controller field, select A, B, or Both.

4. Click Shut down now. A confirmation dialog appears.

5. Click Yes to continue; otherwise click No. If you clicked Yes, a second confirmation dialog appears.

6. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

Note: See the Disk Management Utility (V2) for additional information.

Using the CLI
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log-in to the CLI using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above. 

2. In a dual-controller system, verify that the partner controller is online by running the command: 
show controllers
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3. Shut down the failed controller—A or B—by running the command: 
shutdown aorshutdown b

The blue OK to Remove LED (back of chassis) illuminates to indicate that the controller I/O module can 
be safely removed.

4. Illuminate the identification LED of the chassis that contains the controller I/O module to remove by 
running the command:
set led enclosure 0 on

Note: See QX and QXS CLI Reference Guide for additional information.

Removing a Controller I/O Module or 
Expansion I/O Module

Caution: Dual-Controller Configurations
- In dual-controller configurations featuring one healthy partner controller, there is no need to transport 
failed controller cache to a replacement controller because the cache is duplicated between the 
controllers (subject to volume write optimization setting).
- In a dual-controller environment, you may hot-replace a single controller I/O module in an operational 
chassis, provided you first shut down the faulty controller using the Disk Management Utility or the CLI.
- In a dual-controller environment—if replacing both controller I/O modules—you must adhere to the 
instructions provided in Before You Begin on page 40.

Caution: Single-Controller Configurations
- In a single-controller configuration, if you desire to transport CompactFlash to a replacement 
controller, remove the controller module only after the cache is copied to CompactFlash, which is 
indicated by the Cache Status LED being off (see Transporting CompactFlash).
- In a single-controller environment, you must stop I/O and power off the chassis before replacing the 
controller module.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38. 

Note: Within these procedures, illustrations featuring controller I/O module face plates are generic. 
They do not show host interface ports, and they pertain to all Quantum controller I/O module models. 
For illustrations of model-specific controller face plates, see the QX and QXS Storage Setup Guide.

Illustrations in the controller I/O module replacement procedures show rear panel views of the chassis, and 
IOMs are properly aligned for insertion into the rear panel of the chassis. 

1. Verify that you have successfully shut down the controller I/O module using Disk Management Utility or 
the CLI.

2. Locate the chassis whose Unit Locator LED (front right ear) is illuminated, and within the chassis, locate 
the controller I/O module whose OK to Remove LED is blue (rear panel).
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3. Disconnect any cables connected to the controller.

Label each cable to facilitate re-connection.

4. Turn the thumbscrews counterclockwise until they disengage from the controller (see Figure 37 below).

Figure 37: Disengaging a controller I/O module
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5. Press both latches downward to disconnect the controller I/O module from the midplane (see Figure 38 
below).

Figure 38: Extracting a controller I/O module
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6. Pull the controller I/O module straight out of the chassis such that the controller I/O module remains level 
during removal (see Figure 39 on the next page).

 l Refer to Figure 39 on the next page for 12-drive, 24-drive, or 48-drive  controller I/O module locations 
(2U).

 l Refer to Figure 40 on the next page for the 56-drive controller I/O module locations (4U).

7. Remove the 12-drive, 24-drive, or 48-drive controller I/O module from the chassis (2U).
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Figure 39: Removing a controller I/O module (2U)
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8. Remove the 56-drive controller I/O module from the chassis (4U).

Figure 40: Removing a controller I/O module (4U)

Transporting CompactFlash
This action applies to single-controller configurations only. To prevent data loss in single-controller 
configurations, the CompactFlash must be moved from the failed controller module to the new controller 
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module.

Caution: Do not transport CompactFlash in dual-controller environments. Doing so could cause data 
corruption.

Figure 41: CompactFlash memory card
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Confirm that transporting CompactFlash is the appropriate action to take as specified in the QX and QXS 
Setup Guide. Refer to Figure 41 above when performing the step-procedure that follows.

Note: See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection”.

 

1. Locate the CompactFlash memory card at the midplane-facing end of the failed controller module.

2. Grip the CompactFlash memory card and carefully pull it from the slot in the failed controller module.

3. Label the CompactFlash memory card as Data, and set it aside for safekeeping.

4. Locate the replacement controller module, and carefully remove its installed CompactFlash memory 
card. 
Take care not to confuse this disc with the one labeled Data.

5. Align the CompactFlash memory card labeled Data for insertion into the replacement controller 
module—then insert it into the slot—and push it forward until seated in place.
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Installing a Controller I/O Module or Expansion 
I/O Module

Note: You can install a controller I/O module into an chassis that is powered on, provided you wait 60 
seconds after removing the old controller I/O module. Check controller and midplane power connectors 
before inserting the new controller I/O module into the chassis.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38. 

1. Loosen the thumbscrews; press the latches downward (see Figure 42 on the next page).

2. Ensuring that the controller I/O module is level, slide it into the chassis as far as it will go (1).

A controller I/O module that is only partially seated will prevent optimal performance of the controller I/O 
module. Verify that the controller I/O module is fully seated before continuing. 

3. Press the latches upward to engage the controller I/O module (2); turn the thumbscrews clockwise until 
finger-tight.

 l See Figure 42 on the next page for the 12-drive, 24-drive, or 48-drive  controller I/O module 
installation.

 l See Figure 43 on the next page for the 56-drive controller I/O module installation.

4. Reconnect the cables.

Note: See the QX and QXS Setup Guide for cabling information.

Figure 42 on the next page provides an illustration of the 12-drive, 24-drive, or 48-drive  controller I/O module 
installation (2U).
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Figure 42: Inserting a controller I/O module (2U)

Figure 43 below provides an illustration of the 56-drive controller I/O module installation (4U).

Figure 43: Inserting a controller I/O module (4U)

Caution: In a dual-controller system in which PFU is enabled, when you update firmware on one 
controller, the system automatically updates the partner controller.
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Verifying Component Operation
After replacing the controller I/O module, verify that the FRU OK LED (rear panel) illuminates green, 
indicating that the controller has completed initializing, and is online/operating normally. It may take two to 
five minutes for the replacement controller to become ready. If you are replacing either controller I/O 
module, and PFU is enabled, you may need to wait 30 minutes to ensure that the two controllers—with their 
respective ownership of the vdisks—have enough time to fully stabilize. 

Use Disk Management Utility or the CLI to perform a restart only if necessary.

Caution: See the “Restarting controllers” topic in the WBI or Disk Management Utility User Guide V3 
for more information.

Using Disk Management Utility V3
1. Sign-in to Disk Management Utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the System panel in the banner, click Restart System.

The Controller Restart and Shut Down panel opens.

3. Select Restart operation

4. Select the controller type to restart: Management or Storage.

5. Select the controller I/O module to restart: A, B, or Both.

6. Click OK. A confirmation panel appears.

7. Click Yes to continue; otherwise click No. If you click Yes, a message describes restart activity.

Using Disk Management Utility V2
1. Sign-in to Disk Management Utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the system and select Tools > Shut Down or Restart 
Controller.

3. In the main panel, set the options:

 l Operation: Select Restart.

 l Controller Type: Select the controller type to restart: Management or Storage.

 l Controller: Select the controller I/O module to restart: A, B, or Both.

4. Click Restart now. A confirmation panel appears.

5. Click Yes to continue; otherwise, click No. If you click Yes, a second confirmation diagram appears.

6. Click Yes to continue; otherwise click No. If you click Yes, a message describes restart activity.
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Using the CLI
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

If the chassis’s Unit Locator LED is on, run the following command to turn it off:
set led enclosure 0 off

If the Fault/Service Required LED is amber, the controller I/O module has not gone online, and likely failed 
its self-test. Put the module online by restarting the controller, or by checking the event log for errors.

To restart the Management Controller (A or B), run the following command:
restart mc a or  restart mc b or  restart mc both

To restart the Storage Controller (A or B), run the following command:
restart sc a or  restart sc b or  restart sc both

Note: See the QX and QXS Setup Guide for descriptions of model-specific LEDs.

Updating Firmware
Always update controller firmware when:

 l Installing a new system

 l Adding drive expansion(s)

 l Replacing a controller I/O module(s) or expansion I/O module(s)

Note: Updating controller firmware with expansion modules active ensures that the controller firmware 
and expansion IOM firmware are at a compatible level.

You can view the current versions of firmware in controller I/O modules, expansion I/O modules (in the RAID 
or expansion chassis), and drives, and you can also install new firmware versions.

Note: To ensure success of an online update, select a period of low I/O activity. This helps the update 
complete as quickly as possible and avoids disruptions to hosts and applications due to timeouts. 
Attempting to update a storage system that is processing a large I/O-intensive batch job will likely cause 
hosts to lose connectivity with the storage system.

A RAID chassis can contain one or two controller I/O modules. In a dual-controller system, both controller 
I/O modules should run the same firmware version. Storage systems in a replication set must run compatible 
firmware versions. Always update controller firmware when replacing a controller I/O module.
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If you have a dual-controller system and the PFU option is enabled, when you update one controller, the 
system automatically updates the partner controller. If PFU is disabled, after updating firmware on one 
controller, you must log into the partner controller’s IP address and perform this firmware update on that 
controller also. 

Note: If a vdisk is quarantined, firmware update is not permitted due to the risk of losing unwritten data 
that remains in cache for the vdisk volumes. Before you can update firmware, you must resolve the 
problem that is causing the vdisk to be quarantined, as described in the “Removing a vdisk from 
quarantine” topic in the WBI User Guide or online help.

For best results, the storage system should be in a healthy state before starting firmware update. You can 
update firmware using Disk Management Utility or using FTP (File Transfer Protocol). See the WBI User 
Guide for more information.

Caution: See the “Updating firmware” topic in the  WBI before performing a firmware update.

Remove or Install a 12- and 24-Drive Chassis 
Bezel
Before accessing front panel LEDs, and components, you must first remove the chassis bezel. The removal 
and installation process of the 12- and 24-drive chassis bezel is the same (only one graphic is shown below).

Figure 44: Partial assembly showing bezel alignment (representative example)
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Attach the Chassis Bezel
1. Orient the bezel to align its back side with the front face of the chassis as shown in the figures above.

2. Face the front of the chassis, and while supporting the base of the bezel, position it such that the 
mounting sleeves within the integrated ear caps align with the ball studs.

3. Gently push-fit the bezel onto the ball studs to attach the bezel to the front of the chassis.

Remove the Chassis Bezel
1. While facing the front of the chassis, insert the index finger of each hand into the top of the respective 

(left or right) pocket opening shown in the figures above.

2. Insert the middle finger of each hand into the bottom of the respective opening, with thumbs on the 
bottom of the bezel face.

3. Gently pull the top of the bezel while applying slight inward pressure below, to release the bezel from the 
ball studs.

Replacing a 12- and 24-Drive Module
A drive module consists of a drive in a sled. Drive modules are hot-swappable, which means they can be 
replaced without halting I/O to the vdisks, or powering off the chassis. The new drive module must be of the 
same type, and possess capacity equal to or greater than the one being replaced. Otherwise, the storage 
system cannot use the new drive to reconstruct the disk group.

If one or more disks fail in a disk group and spares of the appropriate size (same or larger) and type (same 
as the failed disks) are available, the storage system automatically uses the spares to reconstruct the disk 
group. Disk group reconstruction does not require I/O to be stopped, so volumes can continue to be used 
while reconstruction is in progress.

If no spares are available, reconstruction does not start automatically. To start reconstruction manually, 
replace each failed disk and designate each replacement disk as a spare. If you have configured the 
dynamic spares feature through the CLI, reconstruction will automatically start for linear disk groups. With 
dynamic spares enabled, if a disk fails and you replace it with a compatible disk, the storage system rescans 
the bus, finds a new disk, automatically designates it a spare, and starts reconstructing the disk group.

For virtual storage only, reconstruction of all disk groups uses a quick-rebuild feature.
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Before You Begin
Caution: Removing a drive module impacts the airflow and cooling ability of the chassis. If the 
internal temperature exceeds acceptable limits, the chassis may overheat and automatically shut 
down or restart. To avoid potential overheating, wait 20 seconds to allow the internal drives to stop 
spinning (HDDs), then insert the new drive module.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38.

Verify Component Failure
Before replacing a drive, perform the following steps to ensure that you have correctly identified the module 
requiring removal and replacement.

Caution: Failure to identify the correct drive module could result in data loss if the wrong drive is 
removed from the chassis. If your chassis has a bezel installed, remove it to view drive LEDs. 
Alternatively, you can observe drive component health via Disk Management Utility.

Drive Fault
When a drive fault occurs, the failed drive’s fault indicator LED, located on the chassis’s front panel, 
illuminates solid amber (see the QX and QXS Setup Guide for a description of LEDs and drive slot 
numbering for your chassis). You can determine from visual inspection which drive in the chassis is 
experiencing a fault/failure using the fault LED for your drive type.

Note: Newer product models use an chassis bezel instead of ear covers. If your model is equipped with 
a bezel instead of ear covers, see the appropriate illustration for bezel installation and removal:

 l See Partial assembly showing bezel alignment (2U24) on page 13 for 2U24 chassis bezel alignment.

 l See Partial assembly showing bezel alignment (2U12)  on page 11 for 2U12 chassis bezel alignment.

Using management interfaces
Alternatively, you can observe drive component health using management interfaces to verify component 
failure or component operation (see Using management interfaces on page 135 for more information).

Using Disk Management Utility V3
1. Sign in to the disk management utility (use default user manage and password !manage, or the 

appropriate username and password if they have been changed).

2. Click the System topic. The System panel opens.

3. Click the Table tab to determine whether the health of the new disk is OK. 
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 l If the health is OK, then the disk drive module installation process is complete. 

 l If the health is not OK, then hover over the disk to display details about it, such as Status and Health 
Recommendations.

Using Disk Management Utility V2
1. Sign in to Disk Management Utility (use default user manage and password !manage, or the appropriate 

username and password if they have been changed).

2. View the System Overview panel to determine whether the health of the new drive is OK. 

 l If the health is OK, then the drive module installation process is complete. 

 l If the health is not OK, then in the Configuration View panel, select the chassis that the new drive is 
in to display the Enclosure Overview panel, and select the drive to view details about it, such as 
Status and Health Recommendations.

Using the CLI
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log in to the CLI (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

2. To view information about drives, run the following command:
show disks <disk-ID>

Drives are specified by enclosure ID and slot number. Enclosure IDs increment from 0. Drive IDs 
increment from 0 in each enclosure (e.g., show disks 0.7). Entering the command shown above will 
display the drive health for the drive residing in slot number 7 of enclosure number 0 (i.e., the controller 
enclosure). If health is not OK, the command output will also display recommended actions.

Remove the 12- or 24-Drive Module
1. Follow one of two sub-steps below, according to your product drive module type ( see Figure 45 on the 

next page):

a. SFF drive (stands on edge) used in 24-drive chassis— Squeeze the latch release flanges together 
to disengage the drive module, and swing the pivoting portion of the latch upwards by 45° (see 
Figure 45 on the next page and Figure 46 on page 58).

b. LFF drive (lays on side) used in 12-drive chassis — Slide the release latch to the left to disengage 
the drive module (see Figure 45 on the next page).
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Moving the latch to the left will provide a clicking sound and cause the spring to move its position 
inside the chassis, partially ejecting the drive from its installed position within the drive slot.

Figure 45: Disengaging a drive module
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1. 24-drive chassis: SFF 2.5" drive or blank 2. 12-drive chassis: LFF 3.5" drive or blank

2. Wait 20 seconds for the internal drives to stop spinning (HDDs).

3. Follow one of the two sub-steps below, according to your product drive type (see Figure 46 on the next 
page):

a. SFF drive used in 24-drive chassis — Firmly grasp the front of the plastic sled, and pull the drive 
module straight out of the chassis, taking care not to drop the module.

b. LFF drive used in 12-drive chassis — Once the drive module partially ejects from the slot, grasp the 
module firmly, and carefully pull it straight out of the chassis slot. Take care not to drop the module.
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Figure 46: Removing a drive module
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1. Extract SFF drive or blank 2. Extract LFF drive or blank

Install the 12- or 24-Drive Module
1. Follow one of the two sub-steps below, according to your product drive module type:

a. SFF drive used in 24-drive chassis — Squeeze the latch release flanges together, and then pull the 
latch, rotating it upward until it is fully open (see Figure 45 on the previous page and Figure 46 
above).

b. LFF drive used in 12-drive chassis — No action required.

Proceed to step 2 below.

2. Follow one of the two sub-steps below, according to your product drive module type:

a. SFF drive used in 24-drive chassis — With the LEDs oriented to the bottom, slide the drive module 
into the drive slot as far as it will go (see left illustration in Figure 47 on the next page).

b. LFF drive used in 12-drive chassis — With the LEDs oriented to the left, slide the drive module into 
the drive slot as far as it will go (see right illustration in Figure 47 on the next page).
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Figure 47: Installing a drive module
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1. 24-drive chassis: Insert SFF drive or blank 2. 12-drive chassis: Insert LFF drive or blank

3. Follow one of the two sub-steps below, according to your product’s drive type:

a. SFF drive used in 24-drive chassi — Rotate the latch downward until it clicks closed to firmly seat the 
drive module in the chassis midplane.

b. LFF drive used in 12-drive chassi — Verify that you have inserted the drive module into the slot as far 
as it will go, to ensure that the module is firmly seated in the chassis midplane.

The installed drive module should now appear as shown in Figure 45 on page 57.

Note: Allow at least 30 seconds to elapse when jointly completing the “Removing a drive module” 
and “Installing a drive module” procedures. 

Use Disk Management Utility V3, Disk Management Utility V3, or the CLI to complete this procedure.

Using Disk Management Utility V3
1. Sign in to the disk management utility (use default user manage and password !manage, or the 

appropriate username and password if they have been changed).

2. Click the System topic. The System panel opens.

3. Click the Table tab to determine whether the health of the new disk is OK. 

 l If the health is OK, then the disk drive module installation process is complete. 

 l If the health is not OK, then hover over the disk to display details about it, such as Status and Health 
Recommendations.
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Using Disk Management Utility V2
1. Sign in to Disk Management Utility (use default user manage and password !manage, or the appropriate 

username and password if they have been changed).

2. View the System Overview panel to determine whether the health of the new drive is OK. 

 l If the health is OK, then the drive module installation process is complete. 

 l If the health is not OK, then in the Configuration View panel, select the chassis that the new drive is 
in to display the Enclosure Overview panel, and select the drive to view details about it, such as 
Status and Health Recommendations.

Setting CLI Preferences
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log in to the CLI (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

2. To view information about drives, run the following command:

show disks <disk-ID>

Drives are specified by enclosure ID and slot number. Enclosure IDs increment from 0. Drive IDs 
increment from 0 in each enclosure (e.g., show disks 0.7). Entering the command shown above will 
display the drive health for the drive residing in slot number 7 of enclosure number 0 (i.e., the RAID 
chassis). If health is not OK, the command output will also display recommended actions.

Determine if a Drive is Missing
You can determine whether a drive is missing by using disk management utility V2, disk management utility 
V3, or the CLI.

Using Disk Management Utility V3
1. Sign-in to the SMC using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. Click the System topic. The System panel opens.

 l Select the Front tab to display a pictorial representation of disks within slots, and hover over 
individual disks to view the metadata such as location, usage, tier, type, and size.
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 l You can hover over chassis/enclosure ears to see metadata for specific chassis/enclosures in the 
system.

 l Select the Table tab to display a tabular view of information about physical components in the 
system.

3. Using the Front and Table views, look for gaps in the disk location sequence to determine if a disk is 
missing.

Using Disk Management Utility V2
1. Sign-in to Disk Management Utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the appropriate chassis/enclosure under Physical.

 l Select the Front Graphical tab to display a pictorial representation of drives within slots, and the 
supporting chassis/enclosure table showing properties and values.

 l Select the Front Tabular tab to display the Enclosure’s Front View data table and supporting 
chassis/enclosure table showing properties and values.

3. Using the graphical and tabular views, look for gaps in the drive location sequence to determine if a drive 
is missing.

Setting CLI Preferences
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log-in to the command-line interface (CLI) using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. To determine location of a missing or faulty drive, run the following command:
show disks

The command outputs a listing of detected drives’ properties by location. Review the information, and 
look for gaps in the drive location sequence to determine whether any drives are missing.

Verify Component Operation
Verify that the Power/Activity LED—located on the front face of the drive escutcheon—is illuminated green. 
On LFF drives, this is the bottom LED. On SFF drives, this is the left LED. Both sets of LEDs are shown in 
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Figure 47 on page 59.

Note: See the QX and QXS Setup Guide for descriptions of drive LEDs and other front panel LEDs 
pertaining to 2U12 and 2U24 RAID chassis.

Also see Using management interfaces on page 135 as an alternative to physically observing LEDs to verify 
component operation.

Remove or Install a 48-Drive Chassis Bezel
Before accessing front panel LEDs, and components, you must first remove the chassis bezel. 

Figure 48: Partial assembly showing bezel alignment (2U48)

1

2

3

1. Chassis bezel (includes EMI shield for drives)

2. Ball stud on chassis ear (typical 4 places on chassis)

3. Pocket opening (typical 2 places on bezel)

Attach the Chassis Bezel
1. Orient the bezel to align its back side with the front face of the chassis as shown in the figures above.

2. Face the front of the chassis, and while supporting the base of the bezel, position it such that the 
mounting sleeves within the integrated ear caps align with the ball studs.

3. Gently push-fit the bezel onto the ball studs to attach the bezel to the front of the chassis.
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Remove the Chassis Bezel
1. While facing the front of the chassis, insert the index finger of each hand into the top of the respective 

(left or right) pocket opening shown in the figures above.

2. Insert the middle finger of each hand into the bottom of the respective opening, with thumbs on the 
bottom of the bezel face.

3. Gently pull the top of the bezel while applying slight inward pressure below, to release the bezel from the 
ball studs.

Accessing a 48-Drive Drawer
The 48-drive chassis includes three different drawers; one for the left (Drawer 0) and middle (Drawer 1) 
drawers, and one for the right (Drawer 2) drawer.

Opening and Closing a Drawer
You can open a drawer for visual inspection of drives while the drawer is in operation. Before accessing the 
drawer via its handle, you must first remove the chassis bezel (see narrative instructions beneath Figure 48 
on the previous page). Given that the chassis bezel is required to provide EMI protection, you should re-
attach the bezel to the chassis after examining the drawer.

1. Using a Torx T15 or straight blade screwdriver, loosen the drawer stop screw on the front face of the 
drawer (see Loosen the drawer stop screw below).

Once the screw is loosened, use the outer thumb wheel to unlock the drawer. Do not remove the screw.

Figure 49: Loosen the drawer stop screw

1 20

2. Revolve the drawer handle upwards by 90° to enable pulling the drawer outward for viewing drives (see 
Revolve the handle to drawer-pull position on the next page).
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Figure 50: Revolve the handle to drawer-pull position

90°

3. Face the front of the drawer—and using the handle—pull the drawer outward along the drawer slide 
until it meets the drawer stop. 

See Opening and closing a drawer: pull or push drawer along slide below.

The open drawer that shown in the example is empty. 

Figure 51: Opening and closing a drawer: pull or push drawer along slide

90°

Figure 52 on the next page shows example alignment of a sledded drive module or AMS insert for 
installation into the drawer. Please see the “Populating drawers” topic within the QX and QXS Setup Guide 
for instructions to install drive modules and AMS inserts into 2U48 drawers.
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Figure 52: Align AMS or drive module for installation into the drawer

1

2

1. AMS

2. Drive

 

Caution: Each drive bay must be populated with four AMS inserts or a full complement of drive 
modules (four SFF 2.5" drives).

Replace a 48-Drive Module
A drive module consists of a drive in a sled. Drive modules are hot-swappable, which means they can be 
replaced without halting I/O to the disk groups, or powering off the chassis. The new drive module must be of 
the same type, and possess capacity equal to or greater than the one being replaced. Otherwise, the 
storage system cannot use the new drive to reconstruct the disk group. 

Note: These are important notes when installing drives within a 2U48 chassis.

 l You must populate the 2U48 chassis in four (4 each) drive increments and populate a vertical slot group 
in the drawer.

 l Always install drives in the 2U48 chassis in slot 0-3 first (drawer 0).

 l Quantum recommends that you distribute additional drives among the three drawers to mitigate potential 
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performance bottlenecks.

 l Populate any empty drive slots with an AMS insert to allow proper cooling of the chassis.

Air Management Solution Insert
An air management solution (AMS) insert—also known as a blank—is a plastic insert that is used in lieu of a 
drive module within a drive bay, to maintain optimal air flow for proper cooling within the chassis. Four blanks 
are installed in drive bays missing all four drive modules. If you must remove a malfunctioning drive module, 
but cannot immediately replace it, you must either leave the faulty module in place, or arrange to replace the 
drive in the bay with a blank.

Note: The blank is used to manage air flow for each slot in the drive bay. Insert blanks in all empty drive 
bay slots within the chassis.

Familiarize yourself with the drive module replacement procedures in this subsection before replacing a 
faulty drive with another drive module, or replacing a drive malfunctioning module in a given bay with a blank 
(proceed to Before You Begin on page 68).

To access drive slots in the drawer bays, you must first do the following:

 l Remove the chassis bezel (see Remove or Install a 48-Drive Chassis Bezel on page 62). 

 l Pull the drawer outward as described in Opening and Closing a Drawer on page 63.

Installing an Air Management Insert
Refer to Figure 53 below when orienting an AMS for insertion into the target drawer. If you are installing into 
the left or middle drawer, refer to the illustrations on the left when performing this step-procedure. If you are 
installing into the right drawer, refer to the illustrations on the right when performing this step-procedure.

Figure 53: Orient the AMS for installation

1. Squeeze the latch release flanges together—so that the locking-nib will clear the sheet metal bay wall—
and insert the AMS into the target drive bay.

2. Verify that the AMS is firmly seated in place.
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The installed AMS insert should now appear as shown in the sectioned cutaway views of the respective 
drawers in Figure 54 below.

Figure 54: Secure the AMS into the drive bay

Removing an Air Management Insert
Refer to Figure 55 below when removing an AMS from the target drawer. If you are extracting from the left 
or middle drawer, refer to the illustration on the left when performing the step procedure. If you are 
extracting from the right drawer, refer to the illustration on the right when performing this step-procedure.

Figure 55: Remove an AMS from the drive bay

1. Squeeze the latch release flanges together—so that the locking-nib will clear the sheet metal bay wall—
and extract the AMS from the target drive bay.

2. Pull the AMS insert straight out of the drive bay as show in Figure 55 above.
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Before You Begin
Caution: Removing a drive module impacts the airflow and cooling ability of the chassis. If the 
internal temperature exceeds acceptable limits, the chassis may overheat and automatically shut 
down or restart. To avoid potential overheating, wait 20 seconds to allow the internal drives to stop 
spinning (HDDs only), then insert the new drive module.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.

Verify Component Failure
Before replacing a drive, perform the following steps to ensure that you have correctly identified the module 
requiring removal and replacement.

Caution: Failure to identify the correct drive module could result in data loss if the wrong drive is 
removed from the chassis. 

For line-of-sight viewing of individual drive LEDs, you must remove the chassis bezel and open the drawer 
to view its installed drives and blanks (if used). When a drive fails or a fault occurs, the drive LED illuminates 
with a 4Hz (4:1) blue blink behavior (see the QX and QXS Setup Guide for a description of LEDs and drive 
slot numbering for your chassis. Also see Appendix A — Drawer description for a summary). You can 
determine from visual inspection which drive in the drawer is experiencing a fault/failure.

Alternatively, you can observe drive component health using management interfaces to verify component 
failure or component operation (see Using management interfaces on page 53 for more information).

Remove a Drive Module
To access drive slots in the drawer bays, you must first do the following:

 l Remove the chassis bezel (see Remove or Install a 48-Drive Chassis Bezel on page 62). 

 l Pull the drawer outward as described in Opening and Closing a Drawer on page 63.

Caution: Drawer and drive slot numbering are described pictorially on the adhesive label laminated to 
the top side of each drawer. Drive slot numbering for drawers 0 (left) and 1 (middle) begins at the front 
of the drawer and moves inward (column-by-column) along the z-axis; whereas drive slot numbering 
for drawer 2 (right) begins at the rear of the drawer and moves outward (column-by-column).

Caution: Familiarize yourself with FDE considerations on page 31before performing this step-
procedure.

If you are removing a drive module from the left drawer or middle drawer, refer to the illustrations on the left 
when performing this step-procedure. If you are removing a drive module from the right drawer, refer to the 
illustrations on the right when performing this step-procedure.

Caution: Be sure to follow these drive module removal guidelines: 
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 l Stop I/O to the drive (see Stopping I/O on page 22).

 l Remove only one drive module at a time: concurrent/multiple drive module removal is not allowed.

 l Remove the drive module (per step procedure)—wait 30 seconds—before removing another drive.

1. Squeeze the latch release flanges together to release the locking-nib on the right side of the sled from 
the drawer cage wall, and disengage the drive module from its connector on the drawer PCBA (see 
illustration for appropriate drawer in Figure 56 below).

Figure 56: Disengaging a drive module

2. Wait 20 seconds for the internal drives to stop spinning. 

3. Firmly grasp the front of the plastic sled, and pull the drive module straight out of the chassis, taking care 
not to drop the module (see illustration for appropriate drawer in Figure 57 below).

Figure 57: Removing a drive module

Install the Drive Module
To access drive slots in the drawer bays, you must first do the following:

 l Remove the chassis bezel (see Remove or Install a 48-Drive Chassis Bezel on page 62). 

 l Pull the drawer outward as described in Opening and Closing a Drawer on page 63.
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Caution: Familiarize yourself with FDE considerations on page 31 before performing this step-
procedure to mitigate the potential for unusable installed drives.

Caution: Be sure to follow drive module installation guidelines :

 l Install only one drive module at a time: concurrent/multiple drive module insertions are not allowed.

 l Install the drive module (per step procedure)—wait 45 seconds—before installing another drive 
module.

The chassis uses an SFF sledded drive positioned to lay on its side—with the drive PCBA facing up—for 
insertion into the drive slot within the drawer. Each drive is mated to a connector on the drawer PCBA. 

If you are installing a drive module in the left drawer or middle drawer, refer to illustrations on the left when 
performing the step-procedure. If you are installing a drive module in the right drawer, refer to illustrations on 
the right when performing this step-procedure.

1. While supporting the bottom of the drive module with one hand (drive PCBA should be facing up and 
latch release flanges should be facing out)—align the drive module for insertion into the target drive slot 
(see illustration for appropriate drawer in Figure 58 below).

2. Using your other hand, squeeze the latch release flanges together—so that the locking-nib will clear the 
sheet metal bay wall—and insert the drive module into the target slot (see illustration for appropriate 
drawer in Figure 58 below).

Figure 58: Aligning the drive module

3. Firmly push the drive module into the slot until the locking nib, on the drive, latches into the drive chassis. 

Note: You will hear a distinct click when the locking nib engages into its chassis drive slot.

Caution: Verify that the drive module locks securely within the chassis. If the drive module is not locked 
securely within the chassis, the drive module might not power on and might not be assessable by the 
controller and/or host.
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Figure 59: Drive module and locking nib

1. Chassis drawer 2. Drive module
3. Locking nib 4. Latch release flanges

Note: Refer to the following link (Training tab) for a video on drive installation: 
http://www.quantum.com/qxshybriddocs

The installed drive module should now appear as shown (see illustration for appropriate drawer in 
Figure 60 on the next page). Wait 45 seconds before installing another drive.

http://www.quantum.com/qxshybriddocs
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Figure 60: Installing a drive module

Note: Allow at least 30 seconds to elapse when jointly completing the “Removing a drive module” 
and “Installing a drive module” procedures. 

Use Disk Management Utility V3, Disk Management Utility V2 or the CLI to complete this procedure.

Using Disk Management Utility V3
1. Sign in to the disk management utility (use default user manage and password !manage, or the 

appropriate username and password if they have been changed).

2. Click the System topic. The System panel opens.

3. Click the Table tab to determine whether the health of the new disk is OK. 

 l If the health is OK, then the disk drive module installation process is complete. 

 l If the health is not OK, then hover over the disk to display details about it, such as Status and Health 
Recommendations.

Using Disk Management Utility V2
1. Sign in to Disk Management Utility (use default user manage and password !manage, or the appropriate 

username and password if they have been changed).

2. View the System Overview panel to determine whether the health of the new drive is OK. 

 l If the health is OK, then the drive module installation process is complete. 

 l If the health is not OK, then in the Configuration View panel, select the chassis that the new drive is 
in to display the Enclosure Overview panel, and select the drive to view details about it, such as 
Status and Health Recommendations.



Chapter 3: Procedures
Remove or Install a 56-Drive Chassis Bezel

QX and QXS CRU Installation and Replacement Guide 73

Using the CLI
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log in to the CLI (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

2. To view information about drives, run the following command:
show disks <disk-ID>

Drives are specified by chassis/enclosure ID and slot number. Enclosure IDs increment from 0. Drive 
IDs increment from 0 in each chassis/enclosure (e.g., show disks 0.7). Entering the command shown 
above will display the drive health for the drive residing in slot number 7 of chassis/enclosure number 0 
(i.e., the RAID chassis). If health is not OK, the command output will also display recommended actions.

Remove or Install a 56-Drive Chassis Bezel
Before accessing front panel LEDs, and components, you must first remove the chassis bezel. 

Figure 61: Partial assembly showing bezel alignment (4U56)

Remove the Chassis Bezel
1. While facing the front of the chassis, insert the index finger of each hand into the top of the respective 
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(left or right) pocket opening.

Figure 62: Removing Chassis Bezel

2. Gently pull the top of the bezel while applying slight inward pressure below to release the top sleeves 
from the ball studs.

3. Lift the bezel upwards to allow the angle-bracket slots to clear the upturned mounting flanges on the 
chassis.

 

Install the Chassis Bezel
1. Orient the bezel to align its back side with the front face of the chassis.
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Figure 63: Installing Chassis Bezel

2. Tilt the bezel forward, and guide the two angle-bracket slots on the backside of the bezel onto the two 
upturned flanges located on sidemount brackets near the front of the chassis (on the exterior left and 
right chassis walls).

3. Gently push-fit the bezel onto the ball studs to attach the bezel to the front of the chassis.

 

Access a 56-Drive Drawer
The 56-Drive chassis includes two different drawers; one for the left (Drawer 0) and right (Drawer 1) 
drawers. 

Open a Drawer
You can open a drawer for visual inspection of drives while the drawer is in operation. Before accessing the 
drawer via its handle, you must first remove the chassis bezel (refer to Bezel Assembly on page 32). Given 
that the chassis bezel is required to provide EMI protection for drives, you should re-attach the bezel to the 
chassis after examining the drawer.
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Figure 64: Loosen the drawer stop screw

DRAWER 0 DRIVES 0 − 27
PN: 21−00000590−00−01 rev A

DRAWER 1 DRIVES 28 − 55
PN: 21−00000590−00−02 rev A

Drawer toggle moved to right position
allows Drawer 0 to pull forward.

Bird’s eye right view (Drawer 1 hidden)

Note:

Loosen screws on target drawer

Enclosure front panel featuring
drawer access components

1. Using a No. 2 Phillips screwdriver, loosen the two screws securing the handle to the front face of the 
drawer (Figure 64 above.

Once the two screws on the target drawer are loosened, turn the thumb wheel counter-clockwise to 
disengage the handle from its upright stowed position.

2. Move the drawer toggle to enable the target drawer to travel along the slide.

Move the toggle to the right to open Drawer 0 (left drawer); or move the toggle to the left to open Drawer 
1 (right drawer).

3. Revolve the drawer handle downwards by 90° to enable pulling the drawer outward for viewing drive 
slots (Figure 65 on the next page).

4. Face the front of the drawer—and using the handle—pull the drawer outward along the drawer slide 
until it meets the first drawer stop.

The second stop is met by using your index fingers to pull the blue clips (located on both sides of the 
drawer) towards the front of the drawer. Pull the drawer outward until it meets the next drawer stop.

Note: Do not pull out a drawer that is fully loaded with drives to the second stop.
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Figure 65: Loosen the drawer stop screw

90°

Drawer handle

S t o w  p o s i t i o n

P u l l  p o s i t i o n

Revolve handle to suit open
and close drawer actions.

Enclosure front panel (partial)

Close a Drawer
To close the drawer, simply slide the drawer into the chassis along the drawer slide until it properly seats in 
the drawer bay. Take care to ensure that no loose cable wires protrude beyond the limits of the igus 
chainflex cable. Note that the drawer will lock at the second stop. 

To release the lock, use your index fingers to pull the blue clips towards the front of the drawer and slide the 
drawer into the chassis. After closing the drawer, revolve the handle upwards such that it is flush with the 
drawer front panel—in stowed position—and tighten the two handle screws. Re-attach the bezel to the front 
of the chassis.

Replace a 56-Drive Module
A drive module consists of a drive in a sled. Drive modules are hot-swappable, which means they can be 
replaced without halting I/O to the vdisks, or powering off the chassis. The new drive module must be of the 
same type, and possess capacity equal to or greater than the one being replaced. Otherwise, the storage 
system cannot use the new drive to reconstruct the vdisk (see “About vdisks” and “About drive failure and 
vdisk reconstruction” topics in the WBI User Guide).
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Note: If replacing a drive within a QXS-5600, you must configure the spare drive as a global hot spare 
for the new drive to rebuild into the system (LUN). After adding this drive as a global hot spare, the 
rebuild starts right away. See QXS-5600 Global Hot Spare Instructions on page 83 for more 
information.

Before You Begin
Caution: Removing a drive module impacts the airflow and cooling ability of the chassis. If the 
internal temperature exceeds acceptable limits, the chassis may overheat and automatically shut 
down or restart. To avoid potential overheating, wait 20 seconds to allow the internal drives to stop 
spinning (HDDs), then insert the new drive module.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38.

Verify Component Failure
Before replacing a drive, perform the following steps to ensure that you have correctly identified the module 
requiring removal and replacement.

Caution: Failure to identify the correct drive module could result in data loss if the wrong drive is 
removed from the chassis. If your chassis has a bezel installed, remove it to view drive LEDs. 
Alternatively, you can observe drive component health via Disk Management Utility.

56-Drive Modules
For line-of-sight viewing of individual drive LEDs, you must remove the chassis bezel and open the drawer 
to view its installed drives and blanks (if used). When a drive fails or a fault occurs, the drive LED illuminates 
with a 4Hz (4:1) blue blink behavior (refer to QX and QXS: Setup Guide for additional information on LEDs). 
You can determine from visual inspection which drive in the drawer is experiencing a fault/failure.

Using management interfaces
Alternatively, you can observe drive component health using management interfaces to verify component 
failure or component operation (see Using management interfaces on page 135 for more information).

Using Disk Management Utility V3
1. Sign in to the disk management utility (use default user manage and password !manage, or the 

appropriate username and password if they have been changed).

2. Click the System topic. The System panel opens.
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3. Click the Table tab to determine whether the health of the new disk is OK. 

 l If the health is OK, then the disk drive module installation process is complete. 

 l If the health is not OK, then hover over the disk to display details about it, such as Status and Health 
Recommendations.

Using Disk Management Utility V2
1. Sign in to Disk Management Utility (use default user manage and password !manage, or the appropriate 

username and password if they have been changed).

2. View the System Overview panel to determine whether the health of the new drive is OK. 

 l If the health is OK, then the drive module installation process is complete. 

 l If the health is not OK, then in the Configuration View panel, select the chassis that the new drive is 
in to display the Enclosure Overview panel, and select the drive to view details about it, such as 
Status and Health Recommendations.

Using the CLI
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log in to the CLI (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

2. To view information about drives, run the following command:
show disks <disk-ID>

Drives are specified by chassis/enclosure ID and slot number. Enclosure IDs increment from 0. Drive 
IDs increment from 0 in each chassis/enclosure (e.g., show disks 0.7). Entering the command shown 
above will display the drive health for the drive residing in slot number 7 of chassis/enclosure number 0 
(i.e., the RAID chassis). If health is not OK, the command output will also display recommended actions.

Remove the 56-Drive Module
To access drive slots in the drawer bays, you must first do the following:

 l Remove the chassis bezel (see narrative instructions following Assembly with bezel removed (4U56) on 
page 31). 

 l Pull the drawer outward as described in Open a Drawer on page 75.
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Caution: Drawer and drive slot numbering are described pictorially on the adhesive label laminated to 
the exterior wall of each drawer. Drive slot numbering for drawers 0 (left) and 1 (right) begins at the 
front of the drawer and moves inward (row-by-row) along the x-axis.

Caution: Drive module removal guidelines:

 l Stop I/O to the drive (see Stop I/O on page 42)

 l Remove only one drive module at a time: concurrent/multiple drive module removal is not allowed.

 l Remove the drive module (per step procedure)—wait 30 seconds—before removing another drive.

1. Refer to Figure 66 below for an illustration of the QXS-5600 system.

2. Using your index finger, slide the release latch—located in the upper pocket on the face of the drive 
module—forward to disengage the drive module (see detail inset view in Figure 15).

Moving the latch forward will provide a clicking sound and cause the spring to move its position inside the 
drawer cage, partially ejecting the drive from its installed position within the drive slot.

Figure 66: Remove a drive from a drawer slot

3. Wait 20 seconds for the internal drives to stop spinning (HDDs).

4. Once the drive module partially ejects from the slot, grasp the module firmly, and carefully pull it straight 
out of the drawer slot. Take care not to drop the module.
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Install a 56-Drive Module
To access drive slots in the drawer bays, you must first do the following:

 l Remove the chassis bezel (see narrative instructions following Assembly with bezel removed (4U56) on 
page 31). 

 l Pull the drawer outward as described in Open a Drawer on page 75.

Caution: Drive module installation guidelines:

 l Install only one drive module at a time: concurrent/multiple drive module insertions are not allowed.

 l Install the drive module (per step procedure)—wait 45 seconds—before installing another drive module.

Caution: As you install multiple drives into the drawer, populate from back row to front row, while 
installing drives into the slots. Provide adequate support for the weight of the extended drawer as you 
install the drives.

An exception to this statement occurs if you are installing drive modules to partially fill a drawer, in which 
case you must install a minimum of 14 drive modules, and they must be placed in contiguous slots closest to 
the front of the drawer. 

Installing a Drive
The chassis uses an LFF sledded drive positioned to stand on end (Figure 67 below), for insertion into the 
drive slot within the drawer FRU. Each drive is mated to a connector on the drawer PCBA.

Figure 67: Install a drive into a drawer slot
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1. With the drive module standing on end—and the LEDs oriented to the left—insert the drive module into 
the vertically-aligned drive slot. Notches on the inside of the drawer will help guide the drive to the 
correct position and seat the drive into the connector on the drawer PCBA.

2. Verify that you have inserted the drive module into the slot as far as it will go. A spring in the drawer slot 
will provide a resistive force when mating the drive to the connector. This will ensure that the module is 
firmly seated in the drawer PCBA.

Note: Allow at least 30 seconds to elapse when jointly completing a removal and installation of a drive.

Caution: If you install an empty drive and intend to use it as a spare, the drive must be enabled as a 
spare in order for this procedure to be complete. Spares can be managed using the Disk Management 
Utility or the CLI.

Using Disk Management Utility V3
1. Sign in to the disk management utility (use default user manage and password !manage, or the 

appropriate username and password if they have been changed).

2. Click the System topic. The System panel opens.

3. Click the Table tab to determine whether the health of the new disk is OK. 

 l If the health is OK, then the disk drive module installation process is complete. 

 l If the health is not OK, then hover over the disk to display details about it, such as Status and Health 
Recommendations.

Using Disk Management Utility V2
1. Sign in to Disk Management Utility (use default user manage and password !manage, or the appropriate 

username and password if they have been changed).

2. View the System Overview panel to determine whether the health of the new drive is OK. 

 l If the health is OK, then the drive module installation process is complete. 

 l If the health is not OK, then in the Configuration View panel, select the chassis that the new drive is 
in to display the Enclosure Overview panel, and select the drive to view details about it, such as 
Status and Health Recommendations.

Using the CLI
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 
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Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log in to the CLI (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

2. To view information about drives, run the following command:
show disks <disk-ID>

Drives are specified by chassis/enclosure ID and slot number. Enclosure IDs increment from 0. Drive 
IDs increment from 0 in each chassis/enclosure (e.g., show disks 0.7). Entering the command shown 
above will display the drive health for the drive residing in slot number 7 of chassis/enclosure number 0 
(i.e., the RAID chassis). If health is not OK, the command output will also display recommended actions.

QXS-5600 Global Hot Spare Instructions
This section provides information on configuring drives as a global hot spare:

 l Using Disk Management Utility V2/Global Hot Spare below

 l Using Disk Management Utility V3/Global Hot Spare on page 85

Note: If replacing a drive within a QXS-5600, you must configure the spare drive as a global hot spare 
for the new drive to rebuild into the system (LUN). After adding this drive as a global hot spare, the 
rebuild starts right away.

Using Disk Management Utility V2/Global Hot Spare
1. Using the Disk Management Utility, go to the Provisioning section and select Manage Global Hot Spares 

(Figure 68 on the next page).
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Figure 68: Manage Global Spares

2. Select the new replacement drive and click on Modify Spares (Figure 69 on the next page).
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Figure 69: Modify Spares

3. As soon as the drive is added to the Global Hot Spare group, the LUN rebuild process initiates 
automatically.

Using Disk Management Utility V3/Global Hot Spare
1. Using the Disk Management Utility, go to the Action tab and select Change Global Spares (Figure 68 on 

the previous page).
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Figure 70: Change Global Spares

2. Select the new replacement drive(s) and click on the “Change” button (Figure 69 on the previous page).
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Figure 71: Select Spares

3. Verify that the “Processing the request” screen appears.

Figure 72: Processing the request screen
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4. Verify that the “Success” screen appears after the process is complete.

Figure 73: Success screen

5. Click on the System icon to view the status of the global spare(s).

Figure 74: Processing the request screen

6. As soon as the drive is added to the Global Hot Spare group, the LUN rebuild process initiates 
automatically.
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Using Disk Management Utility V3
1. Sign in to the disk management utility (use default user manage and password !manage, or the 

appropriate username and password if they have been changed).

2. Click the System topic. The System panel opens.

3. Click the Table tab to determine whether the health of the new disk is OK. 

 l If the health is OK, then the disk drive module installation process is complete. 

 l If the health is not OK, then hover over the disk to display details about it, such as Status and Health 
Recommendations.

Using Disk Management Utility V2
1. Sign in to Disk Management Utility (use default user manage and password !manage, or the appropriate 

username and password if they have been changed).

2. View the System Overview panel to determine whether the health of the new drive is OK. 

 l If the health is OK, then the drive module installation process is complete. 

 l If the health is not OK, then in the Configuration View panel, select the chassis/enclosure that the 
new drive is in to display the Enclosure Overview panel, and select the drive to view details about it, 
such as Status and Health Recommendations.

Setting CLI Preferences
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).

1. Log in to the CLI (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

2. To view information about drives, run the following command:

show disks <disk-ID>

Drives are specified by chassis/enclosure ID and slot number. Enclosure IDs increment from 0. Drive 
IDs increment from 0 in each chassis/enclosure (e.g., show disks 0.7). Entering the command shown 
above will display the drive health for the drive residing in slot number 7 of chassis/enclosure number 0 
(i.e., the RAID chassis). If health is not OK, the command output will also display recommended actions.

Determine if a Drive is Missing
You can determine whether a drive is missing by using disk management utility V2, disk management utility 
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V3, or the CLI.

Using Disk Management Utility V3
1. Sign-in to the SMC using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. Click the System topic. The System panel opens.

 l Select the Front tab to display a pictorial representation of disks within slots, and hover over 
individual disks to view the metadata such as location, usage, tier, type, and size.

 l You can hover over chassis/enclosure ears to see metadata for specific chassis/enclosures in the 
system.

 l Select the Table tab to display a tabular view of information about physical components in the 
system.

3. Using the Front and Table views, look for gaps in the disk location sequence to determine if a disk is 
missing.

Using Disk Management Utility V2
1. Sign-in to Disk Management Utility using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the appropriate chassis/enclosure under Physical.

 l Select the Front Graphical tab to display a pictorial representation of drives within slots, and the 
supporting chassis/enclosure table showing properties and values.

 l Select the Front Tabular tab to display the Enclosure’s Front View data table and supporting 
chassis/enclosure table showing properties and values.

3. Using the graphical and tabular views, look for gaps in the drive location sequence to determine if a drive 
is missing.

Setting CLI Preferences
You can set a CLI preference to use v3 or v2 terminology in command output and system messages. 

Note: The following CLI commands enable you to set the management mode to V3 or V2: 
-Use set protocols to change the default management mode. 
-Use set cli-parameters to change the current management mode for the CLI session. 
The system defaults to V3 for new customers and V2 for existing users. See the CLI Reference Guide 
for more information).
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1. Log-in to the command-line interface (CLI) using default user manage and password !manage.

If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. To determine location of a missing or faulty drive, run the following command:
show disks

The command outputs a listing of detected drives’ properties by location. Review the information, and 
look for gaps in the drive location sequence to determine whether any drives are missing.

Verify Component Operation
Verify that the Power/Activity LED—located on the front face of the drive escutcheon—is illuminated green. 

Note: See the QX and QXS Setup Guide for descriptions of drive LEDs and other front panel LEDs 
pertaining to RAID chassis.

Also see Using management interfaces on page 135 as an alternative to physically observing LEDs to verify 
component operation.

Replace a 12-, 24-, or 48-Drive Chassis PSU
This section provides procedures for replacing a failed AC or DC power supply module, also referred to as a 
power supply unit (PSU). Illustrations in power supply module replacement procedures show rear panel 
views of the chassis, and PSUs are properly aligned for insertion into the rear panel of the chassis.

A single PSU is sufficient to maintain operation of the chassis. You need not halt operations and completely 
power-off the chassis when replacing only one PSU; however, a complete shutdown is required if replacing 
both power supply units. 

Caution: Power supply module replacement activities can cause chassis cables to disconnect and 
drives to go offline. Be careful with cabling connections during module replacement.

If immediate replacement is necessary during I/O, ensure that all cables are securely fastened, and proceed 
with great caution as you replace the power supply module within the chassis. Be very careful if moving a 
cabled/operational chassis during the module replacement process.

Note: See Table 7 on the next page for additional information about power supply faults and 
recommended actions.
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Before You Begin
Caution: Removing a power supply unit significantly disrupts the chassis’s airflow. Do not remove 
the PSU until you have received the replacement module.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38. 

Verify Component Failure
When either a fan or power supply component fails, Disk Management Utility provides notification; faults are 
recorded in the event log; and the PSU’s status LED color changes to amber to indicate a fault condition.

Problem Recommended action

Power supply fan 
warning or failure, or 
power supply 
warning or failure
Event code 551 or 
168
 

 l V3: Verify that all fans are working using the Disk Management Utility. 
Click the System tab within the topics pane and from the System topic, select the 
Rear tab. Hover over each power supply module to view health attributes. You can 
also select the Table tab and view health status for power supply modules and other 
components in tabular form.

 l V2: Verify that all fans are working using Disk Management Utility.
In the Configuration View, expand Physical, right-click the chassis and select View 
> Overview. Select either Rear Graphical or Rear Tabular to view health 
attributes

 l Optionally, you can verify that all fans are working using the CLI.
The show fans command will output health status for fans in the specified chassis.

 l Ensure that the power supply modules are properly seated and secured within their 
slots.

 l Ensure that no slots are left open for more than two minutes. If you must replace the 
FRU, leave the old module in place until the replacement arrives to maintain optimal 
airflow and avoid overheating.

Power supply 
module failure 
status, or voltage 
event notification
Event code 551 or 
168

 l Verify that the power supply module is powered on. If your power supply module has a 
power switch, verify that it is switched on.

 l Verify that the power cables are securely attached to the power supply module and 
the appropriate power source.

 l Replace the module if necessary.

AC Power Good 
LED is off

Same as above.

Table 7: Power supply faults and recommended actions
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Problem Recommended action

Voltage/Fan 
Fault/Service 
Required LED is 
illuminated

Replace the power supply module.

Alternatively, you can observe power supply component health (PSUs, fans) using management interfaces 
to verify component failure or component operation (see Using management interfaces on page 135 for 
more information).

Power Supply Units
Caution: Newer AC power supply units do not have power switches. These PSUs power on when 
connected to a power source, and power off when disconnected.

Power cycling procedures vary according to the type of power supply module included with the chassis. For 
RAID and expansion chassis configured with AC PSUs that do not have power switches, refer to the 
procedure described under Power Off AC and DC PSUs below. For procedures pertaining to a) chassis 
configured with DC PSUs, or b) previously installed expansion chassis featuring power switches, see DC 
and AC PSUs with power switch on the next page.

Note: AC PSUs—with or without a power switch—are compatible with one another in that the two 
different models can coexist in the same chassis, and are interchangeable, provided they are of the 
same form factor/physical size and power rating.
The 56-drive chassis (4U) uses an altogether different power supply unit than the model used for 12-, 
24-, and 48-drive chassis (2U).

Power Off AC and DC PSUs
Chassis configured with AC PSUs that do not have a power switch rely on the power cord for power cycling. 
Connecting the cord from the PSU power cord connector to the appropriate power source facilitates power 
on; whereas disconnecting the cord from the power source facilitates power off. 
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Figure 75: AC PSU

1

1. Power cord connect

Powering off the PSU
1. Stop all I/O from hosts to the chassis (see Stop I/O on page 42).

Note: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

2. Use management software to shut down any other system components necessary.

Given that power switch shut-off does not apply to this particular power supply model, proceed to 
disconnecting the AC power cord.

Note: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

Disconnecting an AC power cord
1. Disconnect the power cord’s male plug from the power source.

2. Disconnect the power cord’s female plug from the power cord connector on the PSU.

Note: See Connect a Power Cable on page 99 for an illustration showing AC power cord 
connection/disconnection.

DC and AC PSUs with power switch
DC and legacy AC power supplies—each equipped with a power switch—are shown below.
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Figure 76: DC power supply with power switch

12

1. DC power switch

2. DC power cable connect

Figure 77: AC power supply with power switch

1

2

1. AC power switch

2. AC power cord connect

Powering off the PSU
1. Stop all I/O from hosts to the chassis (see Stop I/O on page 42).

Note: This step is not required for hot-swapping; however, it is required when replacing both PSUs.
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2. Use management software to shut down any other system components necessary.

Note: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

3. If applicable, turn off the power switch on the PSU being replaced and on the replacement PSU.

Disconnecting an AC power cord
1. If applicable, verify that the power switch on the PSU being replaced is in the Off position.

2. Disconnect the power cord’s male plug from the power source.

3. Disconnect the power cord’s female plug from the power cord connector on the PSU.

Note: See Connect a Power Cable on page 99 for illustrations showing both AC and DC power cord 
connection/disconnection.

Disconnecting a DC power cable
1. Verify that the power switch on the PSU being replaced is in the Off position.

2. Loosen the cable-locking screws that attach each D-shell connector to its power supply, and carefully 
disconnect the lugs on each cable wire component of the DC power cable from the DC power source 
(Figure 83 on page 101 shows cable wire lugs and D-shell connector).

3. Loosen the cable-locking screws attaching the D-shell connector to the PSU, and disconnect the power 
cable from the PSU.

Remove a 12-, 24-, or 48-Drive Chassis PSU
1. If replacing a single power supply module via hot-swap, proceed to step 3.

2. If replacing both power supply modules, verify that the chassis is powered off.

If the PSU model has a power switch, verify that the switch is set to the Off position.

3. Verify that the power cord is disconnected.

4. Turn the thumbscrew at the top of the latch counterclockwise to loosen and disengage it from the 
module; however, do not remove the thumbscrew from the latch.

5. Rotate the latch downward by approximately 45°, supplying sufficient leverage to disconnect the module 
from the internal connector.

See Figure 78 on the next page below.
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Figure 78: Removing a power supply unit (2U)

1

2

3

4

5

1. Power supply unit (installed position)

2. RAID or expansion chassis (cover plates are shown in lieu of IOMs

3. Power supply unit (PSU) - switchless AC model

4. Revolved latch

5. Thumbscrew

6. Use the latch to pull the module straight out of the chassis slot, taking care to support the base of the 
PSU—with both hands—as you remove it from the chassis.

7. If replacing two power supply modules, repeat step 3 through step 6.

Caution: Do not lift the module by its latch; doing so could damage the latch. Using both hands, lift and 
carry the module using its metal casing.
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Install a 12-, 24-, or 48-Drive Chassis PSU
Figure 79: AC model without power switch

Figure 80: AC model with power switch
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Figure 81: Orienting a power supply unit (2U)

To install a power supply module

1. Orient the PSU with the AC or DC power cable connector toward the right as shown in Figure 78 on 
page 97 and Figure 81 above, respectively.

2. With the latch in the open position, ensure that the power supply module is level, and slide it into the 
appropriate power supply slot as far as it will go.

3. Rotate the PSU latch upward until it is flush against the PSU face, ensuring that the connector on the 
PSU engages the connector inside the chassis.

4. Turn the thumbscrew located at the top of the power supply latch clockwise, until it is finger-tight, to 
secure the latch to the power supply unit within the chassis.

5. If replacing two power supply modules, repeat step 1 through step 4.

Note: AC PSUs—with or without a power switch—are compatible with one another in that the two 
different models can coexist in the same chassis, and are interchangeable, provided they are of the 
same form factor/physical size and power rating.

6. See Connect a Power Cable below to attach the power cable(s).

Connect a Power Cable
This section addresses power cable connection for chassis configured with either AC or DC power supply 
modules.
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Figure 82: AC power cord

Connecting an AC power cord
The image in Figure 82 above pertains to AC PSU models (a switchless unit is shown).

 1. Install the power cord

 a. Connect the female plug to the AC PSU cord inlet.

 b. Connect the male plug to the rack power source.

Verify connection of the primary power cord(s) from the rack to separate external power sources.

 2. Power-on the newly-installed PSU

 l Connecting the power cord effectively powers a switchless AC PSU on. Wait several seconds for 
the drives to spin up (HDDs).

 l For AC PSUs equipped with a power switch, press the power switch to the On position.

Wait several seconds for the drives to spin up (HDDs).

 3. If replacing two power supply modules, repeat step 1 and step 2.

Connecting a DC power cable
Locate the DC power cable that applies to the DC PSU being installed in the chassis.
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Figure 83: DC power cable featuring D-shell and lug connectors

1. Install the appropriate DC power cable:

a. Connect a DC power cable to each DC power supply using the D-shell connector. Use the UP> 
arrow on the connector shell to ensure proper positioning (see adjacent left side view of D-shell 
connector).

b. Tighten the screws at the top and bottom of the shell, applying a torque between 1.7 N-m (15 in-lb) 
and 2.3 N-m (20 in-lb), to securely attach the cable to the DC PSU.

c. To complete the DC connection, secure the other end of each cable wire component of the DC 
power cable to the target DC power source. 
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Check the three individual DC cable wire labels before connecting each cable wire lug to its power 
source. One cable wire is labeled ground (GND), and the other two are labeled positive (+L) and 
negative (-L), respectively (see Figure 83 on the previous page above).

2. If you did not perform a hot-swap, power-on storage system components in the order indicated:

Expansion chassis first; RAID chassis next; data host last (if powered down for maintenance).

Examine PSU module status as indicated in the Table 8 on the next page below.

Figure 84: Power supply for AC model

1

2

Figure 85: Power supply for DC model

1

2
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LED No./Description Color State Definition

1 — Input Source Power 
Good 

Green On Power is on and input voltage is normal.

Off Power is off, or input voltage is below the minimum threshold.

2 — Voltage/Fan Fault/
Service Required

Amber On Output voltage is out of range, or a fan is operating below the 
minimum required RPM.

Off Output voltage is normal.

Table 8: Power supply unit LED descriptions

Replace a 56-Drive Chassis PSU and Fan 
Module
This section provides procedures for replacing a failed AC or DC power supply module, also referred to as a 
power supply unit (PSU). Illustrations in power supply module replacement procedures show rear panel 
views of the chassis, and PSUs are properly aligned for insertion into the rear panel of the chassis.

A single PSU is sufficient to maintain operation of the chassis. You need not halt operations and completely 
power-off the chassis when replacing only one PSU; however, a complete shutdown is required if replacing 
both power supply units. 

Caution: Power supply module replacement activities can cause chassis cables to disconnect and 
drives to go offline. Be careful with cabling connections during module replacement.

If immediate replacement is necessary during I/O, ensure that all cables are securely fastened, and proceed 
with great caution as you replace the power supply module within the chassis. Be very careful if moving a 
cabled/operational chassis during the module replacement process.

Note: See Table 9 on the next page for additional information about power supply faults and 
recommended actions.

Before You Begin
Caution: Removing a power supply unit significantly disrupts the chassis’s airflow. Do not remove 
the PSU until you have received the replacement module.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38. 
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Verify Component Failure
When either a fan or power supply component fails, Disk Management Utility provides notification; faults are 
recorded in the event log; and the PSU’s status LED color changes to amber to indicate a fault condition.

Problem Recommended action

Power supply fan 
warning or failure, or 
power supply 
warning or failure
Event code 551 or 
168
 

 l V3: Verify that all fans are working using the Disk Management Utility. 
Click the System tab within the topics pane and from the System topic, select the 
Rear tab. Hover over each power supply module to view health attributes. You can 
also select the Table tab and view health status for power supply modules and other 
components in tabular form.

 l V2: Verify that all fans are working using Disk Management Utility.
In the Configuration View, expand Physical, right-click the chassis and select View 
> Overview. Select either Rear Graphical or Rear Tabular to view health 
attributes

 l Optionally, you can verify that all fans are working using the CLI.
The show fans command will output health status for fans in the specified chassis.

 l Ensure that the power supply modules are properly seated and secured within their 
slots.

 l Ensure that no slots are left open for more than two minutes. If you must replace the 
FRU, leave the old module in place until the replacement arrives to maintain optimal 
airflow and avoid overheating.

Power supply 
module failure 
status, or voltage 
event notification
Event code 551 or 
168

 l Verify that the power supply module is powered on. If your power supply module has a 
power switch, verify that it is switched on.

 l Verify that the power cables are securely attached to the power supply module and 
the appropriate power source.

 l Replace the module if necessary.

AC Power Good 
LED is off

Same as above.

Voltage/Fan 
Fault/Service 
Required LED is 
illuminated

Replace the power supply module.

Table 9: Power supply faults and recommended actions

Alternatively, you can observe power supply component health (PSUs, fans) using management interfaces 
to verify component failure or component operation (see Using management interfaces on page 135 for 
more information).

Power Supply Units
Caution: Newer AC power supply units do not have power switches. These PSUs power on when 
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connected to a power source, and power off when disconnected.

Power cycling procedures vary according to the type of power supply module included with the chassis. For 
RAID and expansion chassis configured with AC PSUs that do not have power switches, refer to the 
procedure described under Replace a 56-Drive Chassis PSU and Fan Module on page 103. For 
procedures pertaining to a) chassis configured with DC PSUs, or b) previously installed expansion chassis 
featuring power switches, see Replace a 56-Drive Chassis PSU and Fan Module on page 103.

Note: AC PSUs—with or without a power switch—are compatible with one another in that the two 
different models can coexist in the same chassis, and are interchangeable, provided they are of the 
same form factor/physical size and power rating.
The 56-drive chassis (4U) uses an altogether different power supply unit than the model used for 12-, 
24-, and 48-drive chassis (2U).

AC and DC PSUs for 56-Drive Chassis
The AC and DC power supply are shown below as they appear when facing the rear panel of the chassis. 
For a midplane-facing view of the PSU, see Figure 86 below.

Figure 86: AC and DC PSUs

1

2

3

4

5

6

1. AC PSU 4. DC PSU

2. AC power connect 5. DC power connect

3. AC power supply switch 6. DC power supply switch

Table 10: AC and DC PSUs for 56-Drive Chassis

 

Power Off the PSU
1. Stop all I/O from hosts to the chassis (see Stop I/O on page 42).
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Note: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

2. Use management software to shut down any other system components necessary.

Note: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

3. If applicable, turn off the power switch on the PSU being replaced and on the replacement PSU.

Disconnect an AC power cord
1. If applicable, verify that the power switch on the PSU being replaced is in the Off position.

2. Disconnect the power cord’s male plug from the power source.

3. Disconnect the power cord’s female plug from the power cord connector on the PSU.

Note: See Connect the Power Cable on page 108 for illustrations showing both AC and DC power 
cord connection/disconnection.

Disconnect a DC power cable
1. Verify that the power switch on the PSU being replaced is in the Off position.

2. Loosen the cable-locking screws that attach each D-shell connector to its power supply, and carefully 
disconnect the lugs on each cable wire component of the DC power cable from the DC power source 
(Figure 91 on page 110 shows cable wire lugs and D-shell connector).

3. Loosen the cable-locking screws attaching the D-shell connector to the PSU, and disconnect the power 
cable from the PSU.

Figure 87: DC power cable featuring D-shell and lug connectors

 

Remove 4U 56-Drive Chassis PSU
1. If replacing a single power supply module via hot-swap, proceed to step 3.

2. If replacing both power supply modules, verify that the chassis is powered off.

Verify that the power switch is set to the Standby position.
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3. Verify that the power cords are both disconnected.

4. Using your index finger, move the red latch up to disconnect the module from the internal connector 
(Figure 88 below).

Figure 88: Removing a power supply unit (4U)

5. Pull the module straight out of the chassis slot, taking care to support the base of the PSU—with both 
hands—as you remove it from the chassis.

6. If replacing two power supply modules, repeat steps 3—5.

Caution: Do not lift the module by its plastic protective cover; doing so could damage the cover. Using 
both hands, lift and carry the module using its metal casing.

Install 4U 56-Drive Chassis PSU
1. Orient the PSU with the power cable connector on the bottom as shown above (Figure 89 on the next 

page).

2. With the handle in the open position, ensure that the power supply module is level, and slide it into the 
appropriate power supply slot as far as it will go.

3. Using your index finger, move the red button up, ensuring that the connector on the PSU engages the 
connector inside the chassis.

4. If replacing two power supply modules, repeat steps 1—3.
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Figure 89: Installing a power supply unit (4U)

5. See Connect the Power Cable below to attach the power cable(s).

 

Connect the Power Cable
This section addresses power cable connection for chassis configured with either AC or DC power supply 
modules.
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Figure 90: AC power cord

Connect an AC power cord
The image in Figure 90 above pertains to AC PSU models (a switchless unit is shown).

 1. Install the power cord

 a. Connect the female plug to the AC PSU cord inlet.

 b. Connect the male plug to the rack power source.

Verify connection of the primary power cord(s) from the rack to separate external power sources.

 2. Power-on the newly-installed PSU

 l Connecting the power cord effectively powers a switchless AC PSU on. Wait several seconds for 
the drives to spin up (HDDs).

 l For AC PSUs equipped with a power switch, press the power switch to the On position.

Wait several seconds for the drives to spin up (HDDs).

 3. If replacing two power supply modules, repeat step 1 and step 2.

Connect a DC power cable
Locate the DC power cable that applies to the DC PSU being installed in the chassis.
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Figure 91: DC power cable featuring D-shell and lug connectors

1. Install the appropriate DC power cable:

a. Connect a DC power cable to each DC power supply using the D-shell connector. Use the UP> 
arrow on the connector shell to ensure proper positioning (see adjacent left side view of D-shell 
connector).

b. Tighten the screws at the top and bottom of the shell, applying a torque between 1.7 N-m (15 in-lb) 
and 2.3 N-m (20 in-lb), to securely attach the cable to the DC PSU.

c. To complete the DC connection, secure the other end of each cable wire component of the DC 
power cable to the target DC power source. 

Check the three individual DC cable wire labels before connecting each cable wire lug to its power 
source. One cable wire is labeled ground (GND), and the other two are labeled positive (+L) and 
negative (-L), respectively (see Figure 91 above above).

2. If you did not perform a hot-swap, power-on storage system components in the order indicated:

Expansion chassis first; RAID chassis next; data host last (if powered down for maintenance).

Verify Component Operation
Examine PSU module status as indicated in the table below.
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Figure 92: Power supply unit LED descriptions

1

2

3

1

2

3

AC PSU DC PSU

LED No./Description Color State Definition

1 — Input Source Power 
Good 

Green On Power is on and input voltage is normal.

Off Power is off, or input voltage is below the minimum threshold.

2 — Voltage/Fan Fault/
Service Required

Amber On Output voltage is out of range, or a fan is operating below the 
minimum required RPM.

Off Output voltage is normal.

3 — DC Power Green On Main output power on.

Off Power is off; main output is off; or a fault is detected.

Table 11: Power supply unit LED descriptions

LEDs for a PSU are located in the top right corner of the module face, as shown in Figure 92 above.

If the Voltage/Fan Fault/Service Required LED is illuminated amber, the PSU module has not gone online, 
and likely failed its self-test. Remove and reinstall the PSU module. In addition to viewing the PSU LEDs, 
verify that the cooling fans are spinning. 

Also see Using management interfaces on page 135 as an alternative to physically observing LEDs to verify 
component operation.

Replace 4U 56-Drive Chassis Fan Control Module
This section provides procedures for replacing a failed fan control module (FCM). Illustrations in fan control 
module replacement procedures show rear panel views of the chassis, and FCMs are properly aligned for 
insertion into the rear panel of the chassis.

A single FCM is sufficient to maintain operation of the chassis. You need not halt operations and completely 
power-off the chassis when replacing only one FCM; however, a complete orderly shutdown is required if 
replacing both fan control modules. 
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Before you begin
Caution: Removing a fan control module significantly disrupts the chassis’s airflow. Do not remove 
the FCM until you have received the replacement module.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38. 

Verify component failure

You can observe fan module component health (PSUs, fans) using LEDs, management interfaces, or a 
combination thereof to verify component failure or component operation (see Using management interfaces 
on page 135 for more information).

When either a fan or power supply component fails, the Disk Management Utility provides notification; faults 
are recorded in the event log; and the FCM’s status LED color changes to amber to indicate a fault condition.

Problem Recommended action

Power supply fan warning 
or failure, or fan module 
warning or failure Event 
code 552 or 558 (4U56)
 

 l V3: Verify that all fans are working using Disk Management Utility.
Click the System tab within the topics pane and from the System topic, select 
the Rear tab. Hover over each fan control module to view health attributes. 
You can also select the Table tab and view health status for fan control 
modules and other components in tabular form.

 l V2: Verify that all fans are working using Disk Management Utility.
In the Configuration View, expand Physical, right-click the chassis and select 
View > Overview. Select either Rear Graphical or Rear Tabular to view 
health attributes.

 l Optionally, you can verify that all fans are working using the CLI.
The show fans command will output health status for fans in the specified 
chassis.

 l Ensure that the power supply modules are properly seated and secured within 
their slots.

 l Ensure that the fan control modules are properly seated and secured within 
their slots.

 l Ensure that no slots are left open for more than two minutes. If you must 
replace the FRU, leave the old module in place until the replacement arrives to 
maintain optimal airflow and avoid overheating.

AC Power Good LED is off Same as above.

Voltage/Fan Fault/Service 
Required LED is illuminated

Replace the power supply module FRU.

Table 12: FCM faults and recommended actions
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Remove the Fan Control Module

1. Refer to Figure 93 below for an illustration of the fan control module.

2. If replacing a single fan control module via hot-swap, proceed to step 3.

3. If replacing both fan control modules, verify that the chassis is powered off.

4. Verify that the power cord is disconnected.

5. Using your index finger, move the latch (located on the right side of the handle) to the left.

Figure 93: Removing a fan control module (4U)

6. While holding the handle with the latch pinched, pull the module straight out of the chassis slot, taking 
care to support the base of the FCM—with both hands—as you remove it from the chassis.

7. If replacing two fan control modules, repeat steps 3—5.

Caution: The fan may continue to rotate after removing the FCM.
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Install the Fan Control Module

1. Refer to Figure 94 below for an illustration of the fan control module.

2. Orient the fan control module with the power connector (located on the back of the FCM) on the top 
right.

There is a stop pin to prevent insertion of the fan control module in the wrong orientation.

3. With the latch in the open position, ensure that the fan control module is level, and slide it into the 
appropriate fan control slot as far as it will go.

When the fan control module has locked into position, you will hear a click from the latch.

4. If replacing two fan control modules, repeat step 1 and step 2.

Figure 94: Installing a fan control module (4U)

Verify Component Operation

Examine fan control module status as indicated in Figure 95 on the next page and Fan control module LED 
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descriptions on the next page.

Figure 95: Installing a fan control module (4U)

1

2

3

LED No./Description Color State Definition

1 — FRU OK Green On Power is on with at least one fan operating normally.

Off Both fans are off; the system is powered off.

2 — Fault/Service 
Required

Amber On Fault detected; event has been acknowledged but the problem 
needs attention.

Off No fault condition exists.

3 — Unit locator White On FRU is identified.

Off Normal operation.

Table 13: Fan control module LED descriptions

Replace 12-, 24-, 48-, and 56-Drive Chassis 
Ear Components
This section provides the following information on replacing the ear components on the 12-, 24-, 48-, and 
56-drive chassis.
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Before You Begin
Caution: Verify that you have the proper FRU kit (left or right) for the ear components being 
replaced.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38. 

Chassis ear kit FRUs are available for the left and right ears of the chassis front panel. The following ear 
components replacement procedure applies to ear kits provided with the 12-, 24-, 48-, and 56-drive 
chassis models, respectively. Refer to the following illustrations pertaining to your product ear kit. 
Illustrations in ear kit replacement procedures show front panel views of each chassis, and ear bezel 
components are properly aligned for attachment to the ears on the front panel of the chassis.

12-Drive Chassis Ear Components
This section provides location of the ear components on the 12-drive chassis (2U).

Figure 96 below shows the left ear bezel of a 2U12 model with the LED circuit board installed. The chassis 
bezel is removed to reveal the left ear and LFF drives. See Figure 5 on page 11 and Newer Bezel 
Assemblies on page 12 for bezel attachment and removal details.

Figure 96: Replacing left ear bezel — 2U12 models (left ear with bezel removed)

Figure 97 on the next page shows the right ear components of a 2U12 model. The chassis bezel is removed 
to reveal the right ear and LFF drives. The LED circuit board is shown exploded from its installed position, 
and aligned with the light pipes, which are integral to the chassis bezel. Individual light pipes are shown 
exploded from the front of the chassis bezel.
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Figure 97: Replacing right ear bezels — 2012 models (right ear explosion)

OK

1

2

3

4

5

1. LED circuit board

2. Unit locator

3. Fault/Service required

4. FRU OK

5. Temperature fault

The chassis bezel attaches to four ball studs on the front of the chassis: each 2U12 ear flange hosts two ball 
studs. Relative to both left and right ear kits for 2U12 models, see Remove Ear Components on page 121 
and Replace 12-, 24-, 48-, and 56-Drive Chassis Ear Components on page 115.

Note: If your 2U12 chassis is equipped with a bezel that employs an optional air filter, refer to the  Bezel 
Kit Installation document—included in your product shipkit—for instructions on servicing the air filter.

24-Drive Chassis Ear Components
This section provides location of the ear components on the 24-drive chassis (2U).

Figure 98 on the next page shows the left ear components of a 2U24 model with the LED circuit board 
installed. The chassis bezel is removed to reveal the left ear and SFF drives. See Figure 9 on page 13 and 
Newer Bezel Assemblies on page 18 for bezel attachment and removal details. 
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Figure 98: Replacing left ear bezel — 2U24 models (left ear with bezels removed, drives shown)

Figure 99 below shows the right ear components of a 2U24 model. The chassis bezel is removed to reveal 
the right ear. The example uses an empty chassis. The LED circuit board is shown exploded from its 
installed position, and aligned with the light pipe sub-assembly, which is integral to the chassis bezel.

Figure 99: Replacing right ear bezel — 2U24 models (empty chassis shown)
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1. LED circuit board

2. Unit locator

3. Fault/Service required

4. FRU OK

5. Temperature fault
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The chassis bezel attaches to four ball studs on the front of the chassis: each 2U24 ear flange hosts two ball 
studs. Relative to both left and right ear kits for 2U24 models, see Remove Ear Components on page 121 
and Replace 12-, 24-, 48-, and 56-Drive Chassis Ear Components on page 115.

 

48-Drive Chassis Ear Components
This section provides location of the ear components on the 48-drive chassis (2U).

Figure 98 on the previous page shows the left ear components of a 2U48 model with the LED circuit board 
installed. The chassis bezel is removed to reveal the left ear and SFF drives. See Figure 9 on page 13 and 
Newer Bezel Assemblies on page 18 for bezel attachment and removal details. 

Figure 100: Replacing left ear bezel — 2U48 models (left drawer shown)

Figure 99 on the previous page shows the right ear components of a 2U48 model. The chassis bezel is 
removed to reveal the right ear flange and the right drawer in closed position. The LED circuit board is 
shown exploded from its installed position—and aligned with the light pipe sub-assembly—which is integral 
to the chassis bezel.
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Figure 101: Replacing right ear bezel — 2U48 models (right drawer shown)
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1. LED circuit board

2. Unit locator

3. Fault/Service required

4. FRU OK

5. Temperature fault

The chassis bezel attaches to four ball studs on the front of the chassis: each 2U48 ear flange hosts two ball 
studs. Relative to both left and right ear kits for 2U48 models, see Remove Ear Components on the next 
page and Replace 12-, 24-, 48-, and 56-Drive Chassis Ear Components on page 115.

 

56-Drive Chassis Ear Components
Note: The chassis bezel attaches to two ball studs (top of chassis) and two upturned flanges (bottom of 
chassis) on the front of the chassis.

Figure 102 on the next page shows the left ear of a 4U56 model with the LED circuit board exploded from its 
installed position on the ear flange. The chassis bezel is removed to reveal the left ear flange and the left 
drawer in closed position.
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Figure 102: Replacing left ear components

Figure 103 below shows the right ear of a 4U56 model. The chassis bezel is removed to reveal the right ear 
flange and the right drawer in closed position. The LED circuit board is shown exploded from its installed 
position—and aligned with the light pipe sub-assembly—which is integral to the chassis bezel.

Figure 103: Replacing right ear components

The chassis bezel attaches to two ball studs (top of chassis) and two upturned flanges (bottom of chassis) 
on the front of the chassis. Relative to both left and right ear kits for 2U48 models, see Remove Ear 
Components below and Replace 12-, 24-, 48-, and 56-Drive Chassis Ear Components on page 115.

Remove Ear Components
See the appropriate ear illustrations for your product model when removing the bezel and ear components:
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1. Stop all I/O from hosts to the system.

2. Use management software to shut down any other components necessary.

3. Power off the chassis.

4. Remove the chassis bezel:

5. On the target ear, loosen the two screws that secure the LED circuit board to the mounting pins on the 
threaded mounting sleeves. Use a No.2 Phillips screw driver.

Note: With the exception of the right ear on the 2U24 chassis, the mounting sleeves protrude forward 
from the ear flange. On 2U24 chassis, an angle bracket is affixed to the front of the right ear, with 
mounting sleeves protruding rightward from the base of the angle bracket.

Remove the screws and retain them for use when installing the new LED circuit board.

6. Remove the ESD cage protecting the LED circuit board, and retain it for reinstallation.

This step applies to the left ear kit replacement for the 2U12, 2U24, 2U48, and 4U56 chassis.

7. Disconnect the flexible ribbon cable from the back of the LED circuit board.

a. Pull gently on the LED circuit board to stretch the ribbon cable attached to the back of the board.

b. Reach behind the LED circuit board, and slightly pull outward on the locking mechanism of the 
connector to release the flexible ribbon cable from the circuit board.

8. Remove the LED circuit board.

This step applies to the left and right ear circuit cards for the 2U12, 2U24, 2U48, and 4U56 chassis.

Install Ear Kit Components
Refer to the appropriate target ear illustration when installing ear kit components for your product:

1. Locate the replacement LED circuit board for the target ear.

2. Verify that the chassis is powered off. Remove both power cords.

3. Install the LED circuit board for the target ear:

a. Properly orient the replacement LED circuit board, and align it for installation onto the ear flange as 
shown in the pertinent illustration (see bullet list above).

b. Release the locking mechanism on the ribbon cable connector, located on the back of the LED 
circuit board, by pulling out on the locking mechanism.

c. While holding the flexible ribbon cable steady, insert it into the connector on the back of the LED 
circuit board, and push in on the locking mechanism to secure the cable connection.

d. Locate the ESD cage and align its through-holes with those on the LED circuit board (applies to left 
ear kit replacement only.

e. Locate the LED circuit board fastener screws that you previously removed, and insert a screw 
through each of the board’s two mounting holes, and into the threaded hole of the sleeve on the ear 
flange.
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f. Take care to ensure that the screw threads correctly mesh with the threads in the hole—in order to 
avoid cross-threading or stripping—and hand tighten them. If a calibrated torque driver is available, 
torque each screw to 3 in./lbs.

g. Verify that the LED circuit board is securely installed and the flexible ribbon cable is fully-seated into 
the connector, and locked in place.

4. Gently slip the chassis bezel cover onto the push-fit mounting ball studs, taking care to guide the LED 
indicators through the bezel’s ear covers.

5. Power on the chassis.

Verify Component Operation
Chassis status LEDs are located on the front of the RAID chassis. During normal operation, the FRU OK 
and Temperature Fault LEDs are green, and the other status LEDs located on the right ear are off.

 

Transceivers Used in CNC Ports
The following systems use Converged Network Controller (CNC) technology:

 l QXS-312 and QXS-324

 l QXS-412, QXS-424, QXS-448, and QXS-456

 l QXS-648 and QXS-656

This allows you to select the desired host interface protocol from available Fibre Channel (FC) or Internet 
SCSI (iSCSI) host interface protocols supported by the system. You can use the management interfaces to 
set all controller I/O module CNC ports to use one of these host interface protocols: 16 Gbit/s FC; 8 Gbit/s 
FC; 10GbE iSCSI; or 1 Gbit/s iSCSI.

Alternatively, you can use the management interfaces to set CNC ports to support a combination of host 
interface protocols. When configuring a combination of host interface protocols, host ports 0 and 1 must be 
set to FC (either both 16 Gbit/s or both 8 Gbit/s), and host ports 2 and 3 must be set to iSCSI (either both 
10GbE or both 1 Gbit/s), provided the CNC ports use the qualified SFP connectors and cables required for 
supporting the selected host interface protocol. CNC ports can be used for host connection or remote 
replication, provided the optional AssuredRemote™ feature is licensed.
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Replace an FC Transceiver
This section provides steps for replacing an SFP transceiver connector used in an FC controller host port. 
An example SFP connector is shown below.

Figure 104: Sample SFP connector 

Before You Begin
Ensure you take proper precautions against static electricity. See Electrostatic Discharge on page 37.

Caution: Mishandling fibre-optic cables can degrade performance. Do not twist, fold, pinch, or step 
on fibre-optic cables. Do not bend them tighter than a 2-inch radius.

Caution: To prevent potential loss of access to data, be sure to identify the correct cable and SFP 
connector for subsequent removal.

Verify Component Failure
Transceivers are part of a data path that includes multiple components, such as the transceiver, a cable, 
another SFP, and an HBA. A reported fault can be caused by any component in the data path. To identify 
the location of the fault, check the Link Status and Activity LEDs on the RAID chassis and server. Also, 
check the cable for kinks, crimping or other possible damage.

Note: See Using LEDs on page 134 for more information about LEDs.
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Remove an SFP Module
Perform the following procedure to remove an SFP connector. When removing an FC SFP that has 
previously limited the port speed — and replacing it with a higher-rated SFP — it is possible, though rare, 
that auto-negotiation will not enable the higher port speed. Rebooting the array or the host resolves the 
problem.  

1. Disconnect the fibre-optic interface cable by squeezing the end of the cable connector.

If the SFP does not have a cable, it should have a plug (retained from installation).

Figure 105: Disconnect fibre-optic interface cable from SFP - Fibre-optic cable attached to SFP  

Figure 106: Disconnect fibre-optic interface cable from SFP - Fibre-optic cable disconnected  

2. SFPs are commonly held in place by a small wire bail actuator. Flip the actuator up.

Figure 107: Flip SFP actuator upwards  

3. Grasp the SFP between your thumb and index finger, and carefully remove it from the controller I/O 
module.
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Install an SFP Module
Perform the following procedure to install an SFP connector.

1. Locate the SFPs that will be used in the CNC ports.

 l If the SFP has a plug, remove it before sliding the connector into the CNC port. Retain the plug.

 l If using different SFPs in combination, locate the appropriate SFP pertaining to each target CNC 
port, and note the port number (0 — 3) into which each SFP will install.

 l See the Disk Management Utility Users Guide for information about configuring CNC ports for use 
with qualified FC or iSCSI SFP options.

2. Install the SFP and connect the host interface cable per Figure 108 below below:

a. Flip the SFP actuator and revolve it downwards.

b. Insert the SFP into the CNC port and ensure that it locks securely into place.

c. Align the fibre-optic interface cable with the duplex jack at the end of installed SFP.

Figure 108: Install SFP into the CNC port

PORT 1

PORT 1

PORT 1

1

2

3

4
5

 
1. SFP Module

2. Target CNC Port

3. Installed SFP Module

4. Fibre-Optic Interface Cable

5. Installed FC Cable into SFP

 

3. Connect the fibre-optic interface cable into the duplex jack at the end of the SFP connector.

4. Repeat steps 1—3 for each SFP requiring installation into a CNC port.

Verify Component Operation
View the Link Status and Link Activity LEDs on the controller I/O module face plate. A blinking LED indicates 
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that no link is detected. Also check the link status and link activity LEDs on the host.

Replace a Storage Chassis
The RAID chassis or expansion chassis replacement procedure replaces a damaged chassis FRU, which 
consists of the structural support metal, the exterior sheet metal housing, and the assembled/installed 
midplane. The procedure includes removing all FRU components from a damaged chassis and installing 
them into a replacement chassis.

Caution: When replacing a chassis, several configuration parameters reset to default. Before 
replacing a chassis, ensure to record the QXS IP address, base information (system name, system 
contact information, system location), zoning and HBA configuration, Ethernet switch configuration, 
and iSCSI connection information (IQNs).

Note: QX and QXS storage using 2U12, 2U24, 2U48, or 4U56 chassis are described in the following 
sections: 

 l  CRUs for 12-drive Chassis on page 8

 l  CRUs for 24-drive Chassis on page 13

 l CRUs for 48-drive Chassis on page 18

 l CRUs for 56-drive Chassis on page 26

Whether your  product is a 2U12, 2U24, 2U48, or 4U56 model, a fully functional replacement chassis 
requires the successful removal and installation of the following components:

2U12, 2U24, and 2U48 Models 4U56 Model

Chassis bezel (covers chassis front panel) Chassis bezel (covers chassis front panel)

All drive modules All drive modules

Ear components Ear components

Two power supply/fan units of the same type (both AC or both 
DC)

Two power supply units of the same type (both 
AC)

N/A Two fan control modules

Two I/O modules (of the same model type) Two I/O modules (of the same model type)

Table 14: 2U12, 2U24, 2U48, and 4U56 Components 

CNC models require the successful removal and installation of qualified SFP options. This procedure makes 
extensive use of the FRU component procedures described elsewhere in Chapter 2.
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Before You Begin
Caution: Do not remove the chassis until you have received the replacement chassis.

For more information, see Preventing Electrostatic Discharge on page 37 and Grounding Methods to 
Prevent Electrostatic Discharge on page 38. 

1. Schedule down time that will allow for shutdown; sixty minutes of replacement work; and restart.

2. Verify the existence of a known/good backup of the system.

3. Record system settings for future use and label all cables.

4. Prepare a suitable static-protected work environment to accommodate chassis replacement.

Verify Component Failure
The chassis FRU includes the chassis’s metal housing and the midplane that connects I/O modules, drive 
modules, and power supply modules. This FRU replaces a chassis that has been damaged, or whose 
midplane has been damaged. Often, a damaged midplane will appear as though an I/O module has failed. If 
you replace an IOM, and it does not remedy the fault, you may need to replace the chassis. 

Alternatively, you can observe chassis health (front panel and rear panel) using management interfaces to 
verify chassis/component failure or chassis/component operation (see Using management interfaces on 
page 135 for more information).

Prepare to Remove a Damaged Storage Chassis
Since you are removing and replacing an entire storage chassis, neither the hot-swap capability that applies 
to replacing individual redundant FRUs in an operational storage chassis, nor the hot-add of a drive chassis 
to an operational storage system, apply to this procedure.

1. Before replacing a RAID chassis, record the following parameters: 

a. QXS IP address

b. Base information (system name, system contact information, system location)

c. Zoning and HBA configuration

d. Ethernet switch configuration

e. iSCSI connection information (IQNs)

2. Stop all I/O from hosts to the system. See Stop I/O on page 42.

3. Shut down the controllers. See Shut Down the Controller I/O Module on page 43.

4. Power off the system (RAID chassis first; expansion chassis next). See Power Supply Units on page 
104, and refer to the power cycling procedures for your particular power supply model.
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Note: You must first remove the chassis bezel and ear components. You will also have to open the 
drawer on the 2U48 and 4U56 models to access the drives.

To accomplish this sequential process See the following procedures

1. Remove the chassis bezel to provide access to front panel 
components.

a. Replacing a 12- and 24-Drive 
Module on page 54
b. Replace a 48-Drive Module 
on page 65
c. Replace a 56-Drive Module 
on page 77

2. Remove disk modules from the damaged chassis.1 
(2U12/2U24 chassis: upon completion, proceed to step 5)

Replacing a 12- and 24-Drive Module on 
page 54

3. Remove disk modules from the damaged chassis.1 (2U48 
chassis: upon completion, proceed to step 5)

Replace a 48-Drive Module on page 65

4. Remove disk modules from the damaged chassis.1 (4U56 
chassis: upon completion, proceed to step 5)

Replace a 56-Drive Module on page 77

5. Remove the ear components from the damaged 
(2U12/2U24/2U48/4U56) chassis.

Replace 12-, 24-, 48-, and 56-Drive Chassis 
Ear Components on page 115

6. Remove power and data cables. a. Replace a 12-, 24-, or 48-Drive 
Chassis PSU on page 91

b. Replace a 56-Drive Chassis 
PSU and Fan Module on page 
103

7. Remove the damaged storage  chassis from the rack. Replace a Storage Chassis on page 127

8. Remove the power supply units from the damaged chassis, 
and install them in the replacement chassis.

a. Replace a 12-, 24-, or 48-Drive 
Chassis PSU on page 91

b. Replace a 56-Drive Chassis 
PSU and Fan Module on page 
103

9. Remove the fan control modules from the damaged chassis, 
and install them in the replacement chassis (4U56 chassis 
only).

Replace a 56-Drive Chassis PSU and Fan 
Module on page 103

10. Remove each IOM from the damaged chassis, and install it in 
the replacement chassis.2

Replacing a Controller I/O Module or 
Expansion I/O Module on page 39

Table 15: Removing and replacing a storage chassis and its CRUs
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To accomplish this sequential process See the following procedures

11. Remove each FC SFP from the damaged chassis, and install 
it in the replacement chassis (Fibre Channel models only).3

Replace an FC Transceiver on page 124

12. Remove each 10GbE SFP from the damaged chassis, and 
install it in the replacement chassis (10GbE iSCSI models 
only).3

Replace an FC Transceiver on page 124

13. Remove each 1 Gb SFP from the damaged chassis, and 
install it in the replacement chassis (1 Gb iSCSI models 
only).3

Replace an FC Transceiver on page 124

14. Install ear kit components on the replacement chassis ear. Replace 12-, 24-, 48-, and 56-Drive Chassis 
Ear Components on page 115

15. Install the replacement storage  chassis in the rack. Replace a Storage Chassis on page 127

16. Install disk drive modules in the replacement chassis.1

(2U48 and 4U56 chassis use drawers for disks)

a. Replacing a 12- and 24-Drive 
Module on page 54

b. Replace a 48-Drive Module on 
page 65

c. Replace a 56-Drive Module on 
page 77

17. Complete the installation process. a. Replacing a 12- and 24-Drive 
Module on page 54

b. Replace a 48-Drive Module on 
page 65

c. Replace a 56-Drive Chassis 
PSU and Fan Module on page 
103
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To accomplish this sequential process See the following procedures

18. Verify proper operation for all removed and installed FRU 
components.

Note: Refer to Reset QXS Configuration Parameters 
below to input configuration parameters.

Refer to Acquire New License after RAID Chassis 
Replacement to complete the chassis installation.

Note 1: Complete "Verifying Component 
Operation" in each of the following sections.

a. Replacing a 12- and 24-Drive 
Module on page 54

b. Replace a 48-Drive Module on 
page 65

c. Replace a 56-Drive Module on 
page 77

d. Replacing a Controller I/O 
Module or Expansion I/O 
Module on page 39

e. Replace a 12-, 24-, or 48-Drive 
Chassis PSU on page 91

f. Replace a 56-Drive Chassis 
PSU and Fan Module on page 
103

g. Replace an FC Transceiver on 
page 124

Note 2: Verify PFU is enabled (if 
applicable). See Updating Firmware on page 
52.

 

1Within the replacement chassis, reinstall each drive or drive blank into the same drive slot from which it was removed from 
the damaged chassis.

2Within the replacement chassis, the IOM(s) and IOM blank—if applicable—must be reinstalled into the same IOM slots from 
which they were extracted from the damaged chassis.

3If your chassis model does not use CNC ports, ignore this step.

Reset QXS Configuration Parameters
Note: Since the QXS configuration information reset to default. Complete the following steps using the 
recorded information from the malfunctioning chassis.

1. Configure the QXS IP address.

2. Configure the base Information (System Name, System Contact information, System Location).

3. Check the Zoning and HBA configuration to adapt the changes in the WWN.

4. Check for potential required changes in Ethernet switch configuration because of the change mac 
address (firewall settings).

5. In case of ISCSI, look for the iSCSI connection with the changed IQN's.
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Acquire New License after RAID Chassis Replacement
Note: GSC must use the COD License Manager in Oracle to add the new serial number into QuIL.

1. Service orders a replacement chassis from Choice Logistics.

2. Quantum Logistics receives the confirmation email from Choice with the new serial number being 
shipped.

3. Quantum Logistics enters the new serial number in Oracle IB (replaces original serial number).

4. Customer/Partner/Quantum contacts GSC for Auth Codes and provides the new Base/Array serial 
number.  

5. GSC adds the new serial number to QuIL through Oracle “COD License Manager QTM” module.

a. Select “COD License Manager QTM” module from Oracle Main Menu.

b. Select “Adjust Licensable Product”.

c. Enter new serial number in “Serial Number” field.

6. GSC emails the new Auth Codes for the license set based on the original licenses in Oracle IB.

7. Customer/Partner/Quantum enters the Auth Codes in QuIL to retrieve licenses.

Remove a Damaged Storage Chassis From the Rack
This section provides a procedure for removing a damaged storage  chassis from its rack location.

Caution: 
-It is recommended that all drive modules be removed before removing the chassis. If this is not 
possible, two people are required to move the chassis. 

1. Disconnect the power cables and data cables between devices as needed:

a. Between the cascaded espansion chassis.

b. Between the controller and peripheral SAN devices.

c. Between the controller and the host.

2. Make sure the ear components are removed. See Remove Ear Components on page 121.

3. Remove the retaining screws that secure the front and rear of the chassis to the rack and rails.

4. Maintaining a level position, carefully slide the chassis from the rack.

5. Place the chassis on a work surface near the replacement chassis, the removed drive modules, ear 
bezel components, and screws.

6. Remove the side bracket from each side of the damaged chassis, and retain these rackmount items with 
the other components for future use.
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Install Replacement Storage Chassis in Rack
This section provides a procedure for installing the replacement chassis in its rack location.

Caution: 
-It is recommended that all drive modules be removed before lifting the chassis. If this is not possible, 
two people are required to move the chassis. 

Note: Refer to the applicable rackmount install guide for the correct procedure and mounting 
hardware.

1. Attach side brackets (standard rackmount installation) or main brackets (2-post rackmount installation) 
on the replacement chassis.

2. Support the bottom of the chassis. Carefully lift/align the chassis and while maintaining a level position 
for the chassis, slide it into the rack.

3. Using the appropriate mounting hardware, secure the chassis to the rack.

4. Install the ear bezels. See Replace 12-, 24-, 48-, and 56-Drive Chassis Ear Components on page 115.

5. Using the applicable retaining screws, secure the front and rear or the chassis to the rack and rails.

6. Attach the chassis bezel to the front panel of the chassis. Refer to one of the following: 

 l QX and QXS Bezel Installation Guide

 l Replace 12-, 24-, 48-, and 56-Drive Chassis Ear Components on page 115

Complete the Process
This section provides a procedure for ensuring that the FRU components installed in the replacement RAID 
chassis function properly.

1. Reconnect data cables between devices, as needed, to return to the original cabling configuration:

 l Between cascaded chassis.

 l Between the controller and peripheral or SAN devices.

 l Between the RAID chassis and the host.

2. Reconnect power cables to the RAID chassis.

3. Turn on the power switch to power supply modules if they are equipped with power switches.

Note: For powering-on AC PSUs with or without a power switch, and DC and AC PSUs with a power 
switch, see Power Supply Units on page 104.

Verify Component Operation
1. Restart system devices in the following sequence. Allow time for each device to complete its Power On 

Self Tests (POST) before proceeding:
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a. Expansion chassis

b. RAID chassis

c. Host (if powered down for maintenance)

2. Perform a rescan to force a fresh discovery of all expansion chassis connected to the RAID chassis. This 
step clears the internal SAS layout information, reassigns chassis/enclosure IDs, and ensures that the 
chassis are displayed in the proper order. Use either the CLI or Disk Management Utility (V2 or V3) to 
perform the rescan:

Using CLI
To perform a rescan using the CLI, enter the following command:

rescan

Using Disk Management Utility V3
To perform a rescan using Disk Management Utility, follow the substeps below:

a. Verify that the controllers are operating normally.

b. In the Configuration View panel, right-click the system and select Tools > Rescan Disk Channels.

c. Click Rescan.

See “Correcting chassis/enclosure IDs” in the Setup Guide for additional information.

Using Disk Management Utility V2
To perform a rescan using Disk Management Utility, follow the substeps below:

a. Verify that both controllers are operating normally.

b. In the Configuration View panel, right-click the system and select Tools > Rescan Disk Channels.

c. Click Rescan.

See “Correcting chassis/enclosure IDs” in the Setup Guide for additional information.

Using LEDs
View LEDs on the front and rear of the chassis (see “LED descriptions” within the QX and QXS Storage 
Setup Guide for more information).

Verify front panel LEDs:

 l Verify that the Enclosure ID LED (located on the left ear) is illuminated green.
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 l Verify that the FRU OK and Temperature Fault LEDs are illuminated green, and that the Fault/Service 
Required LED is off (all three LEDs are located on the right ear).

 l For LFF drives, verify that the Power/Activity LED (bottom LED on front of drive) is illuminated green or 
blinking green.

Remove the chassis bezel to view drive LEDs. Attach the bezel when finished viewing drive LEDs.

 l For SFF drives, verify that the Power/Activity LED (left LED on front of drive) is illuminated green or 
blinking green.

Remove the chassis bezel to view drive LEDs. Attach the bezel when finished viewing drive LEDs.

Verify rear panel LEDs:

 l Verify that each power supply module’s Input Source Power Good LED (top LED on PSU) is illuminated 
green.

 l Verify that the FRU OK LED on each IOM face plate is illuminated green, indicating that the module has 
completed initializing, and is online.

Using management interfaces
In addition to viewing LEDs as described above, you can use management interfaces to monitor the health 
status of the system and its components, provided you have configured and provisioned the system, and 
enabled event notification (see “Getting Started” within the WBI or Disk Management Utility User Guide V3 
for more information). 

Select from the following methods to verify component operation:

 l Use Disk Management Utility to check the health icons/values of the system and its components to either 
ensure that everything is okay, or to drill down to a problem component. Disk Management Utility uses 
health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If you 
discover a problem component, follow the actions in its Health Recommendations field to resolve the 
problem.

 l As an alternative to using Disk Management Utility, you can run the show system command in the CLI 
to view the health of the system and its components. If any component has a problem, the system health 
will be Degraded, Fault, or Unknown. If you discover a problem component, follow the actions in its 
Health Recommendations field to resolve the problem.

 l Monitor event notification — With event notification configured and enabled, you can view event logs to 
monitor the health of the system and its components. If a message tells you to check whether an event 
has been logged, or to view information about an event in the log, you can do so using either Disk 
Management Utility or the CLI. Using Disk Management Utility, you would view the event log and then 
hover over the event message to see detail about that event. Using the CLI, you would run the show 
events detail command (with additional parameters to filter the output) to see the detail for an event 
(see “Alphabetical list of commands > show events” within the  QX and QXS CLI Reference Guide for 
more information about command syntax and parameters).
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